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Notice
While reasonable efforts were made to ensure that the information in this 
document was complete and accurate at the time of printing, Avaya Inc. 
can assume no liability for any errors. Changes and corrections to the 
information in this document may be incorporated in future releases.

Preventing toll fraud
"Toll fraud" is the unauthorized use of your telecommunications system 
by an unauthorized party (for example, anyone who is not a corporate 
employee, agent, subcontractor, or person working on your company's 
behalf). Be aware that there may be a risk of toll fraud associated with 
your system and that, if toll fraud occurs, it can result in substantial 
additional charges for your telecommunications services.

Avaya fraud intervention
If you suspect that you are being victimized by toll fraud and you need 
technical assistance or support, call Technical Service Center Toll Fraud 
Intervention Hotline at +1-800-643-2353 for the United States and 
Canada. For additional support telephone numbers, see the Avaya Web 
site:
http://www.avaya.com 
Select Support, then select Escalation Lists. This Web site includes 
telephone numbers for escalation within the United States. For escalation 
telephone numbers outside the United States, select Global Escalation 
List.

Providing telecommunications security
Telecommunications security (of voice, data, and video communications) 
is the prevention of any type of intrusion to (that is, either unauthorized or 
malicious access to or use of) your company's telecommunications 
equipment by some party.
Your company's "telecommunications equipment" includes both this 
Avaya product and any other voice/data/video equipment that could be 
accessed via this Avaya product (that is, "networked equipment").
An "outside party" is anyone who is not a corporate employee, agent, 
subcontractor, or person working on your company's behalf. Whereas, a 
"malicious party" is anyone (including someone who may be otherwise 
authorized) who accesses your telecommunications equipment with 
either malicious or mischievous intent.
Such intrusions may be either to/through synchronous (time-multiplexed 
and/or circuit-based) or asynchronous (character-, message-, or 
packet-based) equipment or interfaces for reasons of:

� Use (of capabilities special to the accessed equipment)
� Theft (such as, of intellectual property, financial assets, or 

toll-facility access)
� Eavesdropping (privacy invasions to humans)
� Mischief (troubling, but apparently innocuous, tampering)
� Harm (such as harmful tampering, data loss or alteration, 

regardless of motive or intent)
Be aware that there may be a risk of unauthorized intrusions associated 
with your system and/or its networked equipment. Also realize that, if 
such an intrusion should occur, it could result in a variety of losses to your 
company (including, but not limited to, human and data privacy, 
intellectual property, material assets, financial resources, labor costs, and 
legal costs).

Your responsibility for your company's telecommunications 
security
The final responsibility for securing both this system and its networked 
equipment rests with you, an Avaya customer's system administrator, 
your telecommunications peers, and your managers. Base the fulfillment 
of your responsibility on acquired knowledge and resources from a 
variety of sources, including, but not limited to:

� Installation documents
� System administration documents
� Security documents
� Hardware-/software-based security tools
� Shared information between you and your peers
� Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and 
your peers should carefully program and configure:

� Your Avaya-provided telecommunications systems and their 
interfaces

� Your Avaya-provided software applications, as well as their 
underlying hardware/software platforms and interfaces

� Any other equipment networked to your Avaya products.

Warranty
Avaya Inc. provides a limited warranty on this product. Refer to your 
sales agreement to establish the terms of the limited warranty. In 

addition, Avaya�s standard warranty language, as well as information 
regarding support for this product, while under warranty, is available 
through the following Web site:
http://www.avaya.com/support 

Link disclaimer
Avaya Inc. is not responsible for the contents or reliability of any linked 
Web sites and does not necessarily endorse the products, services, or 
information described or offered within them. We cannot guarantee that 
these links will work all of the time and we have no control over the 
availability of the linked pages.

Trademarks
Avaya is a trademark of Avaya Inc.

All trademarks identified by the ® or � are registered trademarks or 
trademarks, respectively, of Avaya Inc. All other trademarks are the 
property of their respective owners.

Ordering information: Avaya Publications Center
Voice: +1-207-866-6701

1-800-457-1764 (Toll-free, U.S. and Canada only)

Fax: +1-207-626-7269
1-800-457-1764 (Toll-free, U.S. and Canada only)

Write: Globalware Solutions
200 Ward Hill Avenue
Haverhill, MA 01835 USA
Attention: Avaya Account Manager

Web: http://www.avayadocs.com 
E-mail: totalware@gwsmail.com 
Order: Document # 585-248-506, Issue 1.0

August 2003

Avaya support
Avaya provides a telephone number for you to use to report problems or 
to ask questions about your contact center. The support telephone 
number is 1-800-242-2121 in the United States. For additional support 
telephone numbers, see the Avaya Web site:
http://www.avaya.com 
Select Support, then select Escalation Lists. This Web site includes 
telephone numbers for escalation within the United States. For escalation 
telephone numbers outside the United States, select Global Escalation 
List.

Comments
To comment on this document, send e-mail to crminfodev@avaya.com.
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Preface

Avaya Operational Analyst Release 6.1 (OA) allows businesses to perform operational 
reporting for a multimedia contact center. OA is a required component of Avaya Interaction 
Center 6.1 (IC), functioning as its operational data store and contact center performance 
analysis system. OA is also an optional add-on to Avaya Call Management System (CMS) 
for extended, online historical data storage and multi-site analysis.

This section includes the following topics:

● Purpose of this document on page 10

● Intended users of this document on page 10

● Overview of this document on page 10

● Safety labels on page 11

● Reasons for reissuing this document on page 11

● Availability of this document on page 11

● Related documentation on page 12
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Purpose of this document
The purpose of this document is to describe the reporting capabilities of Operational 
Analyst. Both Basic Reports and Advanced Reports are described with suggestions for 
how they may be used to help manage a multimedia contact center.

Intended users of this document
This document is written for:

● Contact Center managers and supervisors

● Contact Center system administrators

Users of this document should have a working knowledge of Avaya Interaction Center (IC) 
or Avaya Call Management System (CMS), or both, and how they interact with Operational 
Analyst.

Overview of this document
This document includes the following topics:

● Operational Analyst report features on page 13 - Introduces Operational Analyst reports 
and the Customer Interaction Repository.

● Basic Reports on page 23 - Identifies the provided Basic Reports and offers suggestions 
on how you can use Basic Reports in your Contact Center environment.

● Advanced reports on page 83 - Explains cubes and Advanced Reports, and how they 
can help you monitor your Contact Center.

● Optional support tasks for Advanced Reports on page 119 - Provides information about 
some optional tasks you may perform to enhance the operation of Advanced Reports.

● Glossary on page 137 � Defines terms, including abbreviations and acronyms, used in 
this document. 

● Index on page 151 � Lists topics covered in this document, giving page numbers where 
each topic is mentioned.
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Safety labels
If you see any of the following safety labels in this document, take careful note of the 
information presented.

! CAUTION:
CAUTION: Caution statements call attention to situations that can result in harm to 

software, loss of data, or an interruption in service.

! WARNING:
WARNING: Warning statements call attention to situations that can result in harm to 

hardware or equipment.

! DANGER:
DANGER: Danger statements call attention to situations that can result in harm to 

personnel.

! SECURITY ALERT:
SECURITY ALERT: Security alert statements call attention to situations that can increase the 

potential for unauthorized use of a telecommunications system.

Reasons for reissuing this document
This is the first issue of this document. However, much of the content was previously 
issued in Avaya Operational Analyst Release 6.0 Reporting Tools Guide. That information 
has been updated to reflect the current functionality provided by Operational Analyst 
Release 6.1.

Availability of this document
Copies of this document are available from one or both of the following sources. Although 
there is no charge for documents obtained through the Avaya Web site, documents 
obtained through the Avaya Publications Center must be purchased.

● The Avaya online support Web site, http://www.avayadocs.com. 

● The Avaya Publications Center:

http://www.avayadocs.com


Preface

12 Operational Analyst R6.1 Reports Reference

Voice: +1-207-866-6701
+1-800-457-1764 (Toll-free, U.S. and Canada only)

Fax: +1-207-626-7269
+1-800-457-1764 (Toll-free, U.S. and Canada only)

Write: Globalware Solutions
200 Ward Hill Avenue
Haverhill, MA 01835 USA
Attention: Avaya Account Manager

E-mail: totalware@gwsmail.com

Related documentation
You might find the following documentation useful.

Avaya documentation:
Avaya documentation is available through the Avaya online support Web site, 
http://www.avayadocs.com.

● Avaya Operational Analyst Release 6.1 Installation Planning and Prerequisites, Issue 
1.0, August 2003, Avaya document number 585-248-118.

● Avaya Operational Analyst Release 6.1 Installation and Configuration, Issue 1.0, August 
2003, Avaya document number 585-248-119.

● Avaya Operational Analyst Release 6.1 Maintenance and Troubleshooting, Issue 1.0, 
August 2003, Avaya document number 585-248-120.

● Avaya IC Installation and Configuration, Issue 1.1, August 2003, Avaya document 
number 585-248-102.

● Avaya Database Designer Application Reference, Issue 1.1, August 2003 Avaya 
document number 585-248-215.

● IC 6.1 Administration Volume 1: Servers & Domains, Issue 1.1, August 2003, Avaya 
document number 585-248-503.

Other documentation:
● Troubleshooting information associated with the server you are using. Such information 

is typically part of an administration manual.

http://www.avayadocs.com
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Operational Analyst report features

OA reports provide real-time and historical views of contact center statistics. The data from 
which the statistics are computed resides in the Customer Interaction Repository. This 
section introduces you to the repository and the reports.

This section includes the following topics:

● Customer Interaction Repository on page 14

● Basic reports on page 14

● Advanced reports on page 18
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Customer Interaction Repository
The multichannel Customer Interaction Repository features a common catalog of detailed 
customer data that can contain multichannel data from Avaya Interaction Center (IC) and 
voice data from Avaya Call Management System (CMS). The term Customer Interaction 
Repository refers to a collection of database tables that is used to record summarized 
information about activities in your contact center. Refer to the data model (located at 
docs/Data_Models/index.html on the Operational Analyst Release 6.1 product CD) 
for a complete description of the shared repository used to support IC and OA. 

Before you can use various Business Intelligence capabilities, you must install the 
corresponding database(s) by:

1. Installing the Design files defining the database(s).

2. Configuring the database(s) in Database Designer.

3. Importing the phone, email, and web application mappings for contact data storage.

4. Generating the Avaya application(s) in Database Designer.

For complete instructions on installing the Customer Interaction Repository and IC 
application databases, see Avaya IC Installation and Configuration. For detailed 
instructions on use of Database Designer, see Avaya Database Designer Application 
Reference.

Basic reports
Operational Analyst Basic Reports are designed for contact center supervisors with 
performance and task-level priorities. A browser-based interface provides reporting across 
all channels. Data is presented in clear, compelling three-dimensional graphics or sortable 
tables. Available reports include:

● Predefined historical reports across IC and CMS (including External Call History and 
summary interval data).

● Real-time monitoring and historical performance analysis for agents, service classes, 
queues and jobs. 

This section includes the following topics:

● Graphical reports on page 15

● Tabular reports on page 17

● Real-time reports on page 17

● Historical reports on page 17
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Graphical reports
Graphical reports present real-time and historical data in a three dimensional, interactive 
landscape that helps you to better visualize the data in the report and to more easily 
recognize anomalies and trends.

The following illustrates one such report.
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Some real-time reports, like Agent Performance and Service Class and Queue 
Performance, do not contain wall regions as the following illustration shows.
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Tabular reports
Tabular reports present data in sortable tables.

Real-time reports
The real-time reporting capabilities of Basic Reports:

● Permit supervisors and contact center managers to track real-time agent and contact 
activity across Interaction Center channels.

● Permit managers to determine bottlenecks and quickly adjust agent schedules 
accordingly.

Historical reports
The historical reporting capabilities of Basic Reports:

● Permit long-term trending and analysis of contact center performance.
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● Provide predefined reports across all channels.

● Provide multi-site, multi-channel IC reporting.

● Provide long-term analysis of multi-site CMS voice contact data, as a valuable add-on to 
the CMS system.

● Provide integrated reports across IC and CMS contact data.

Advanced reports
Operational Analyst Advanced Reports are designed for sophisticated users and business 
analysts who need to track key performance indicators and trends for operational 
improvement. A browser-based interface provides data in analytical �cubes� - 
multi-dimensional graphic representations of data. Cubes may be manipulated with a 
straightforward graphical tool to produce various perspectives on the data and on-screen 
performance metrics illustrate the business value of each interaction. 

Advanced Reports include predefined business value OLAP (online analytical processing) 
reports and ad hoc querying. The ability to select graphic elements to drill down to 
supporting transaction detail allows you to perform sophisticated business analysis. 

Advanced Reports provide historical analysis on each IC channel as well as reporting for 
the IC Business Applications. Advanced Reports also provide the ability to create custom 
reports and insert custom calculations.

Note:
Note: You should have at least a basic knowledge of Cognos to successfully 

interact with Advanced Reports.

This section includes the following topics:

● Multidimensional cubes on page 18

● Multidimensional reports on page 19

● Ad-Hoc reports on page 21

● Cognos tools on page 22

Multidimensional cubes
Multidimensional cubes are built using Cognos Transformer. Cubes contain information on 
multichannel contact center statistics and trends. Cubes present a predefined set of 
measures and dimensions you may select for viewing. You may select the graphical 
display method, for example, pie chart, cross tab, or bar graph. You can easily generate 
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new reports by graphically selecting measures and dimensions from the cube you wish to 
view in a report.

Multidimensional reports
Predefined multidimensional reports, built using Cognos PowerPlay, run against cubes and 
provide easy analysis and long-term trending of data. Multidimensional cubes and 
associated reports are typically updated on a nightly basis drawing from data in the 
Customer Interaction Repository.

Here are some sample PowerPlay reports:
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Ad-Hoc reports
Ad-Hoc reports, built using Cognos Impromptu, are detailed reports that allow 
sophisticated users the ability to generate ad-hoc queries against the data in the Customer 
Interaction Repository. 

Here are two sample Impromptu reports:
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Cognos tools
Advanced Reports use the following tools from Cognos: 

● Impromptu Administrator to set up the Advanced reports environment, generate query 
files, and build ad-hoc reports.

● Transformer to create and modify cubes.

● PowerPlay to view cubes and reports.

● Power Play Enterprise Server for publishing multidimensional cubes and PowerPlay 
reports on the Web.

● Impromptu Web Report for publishing Impromptu Reports.

A standard installation of Advanced Reports includes only Impromptu and PowerPlay. If 
you decide to install more of the available Cognos tools, please contact your Avaya 
representative.
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Basic Reports

Operational Analyst Basic Reports feature 3-D visualization for real time monitoring and 
historical reporting. Real time performance monitoring is provided across Interaction 
Center channels, including monitoring real time routing statistics. Predefined historical 
reports deliver start-to-end reporting across IC and CMS External Call History data and 
30-minute CMS summary interval data.

This section includes the following topics:

● Launching a report on page 24

● Saving a report configuration on page 26

● Troubleshooting a report on page 27

● User Interface on page 28

● Predefined reports on page 43

● Report descriptions on page 46
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Launching a report
Basic reports are launched and displayed in a Web browser, by linking to a URL (Uniform 
Resource Locator) provided by your system administrator. The URL will be similar to this:

http://<fully qualified hostname>:<port number if needed>/reports1

This illustration shows the default browser window. The left frame of the browser window 
contains a tree-view of reports, followed by My Saved Reports, User Settings, Browser 
Test, General Report Help and Install Reporting Support Files.

Note:
Note: The tree-view may be altered for your particular installation of Operational 

Analyst.

The first time you run Basic reports, you must download and install the Java Runtime 
Environment (JRE) and the report client files. To download the necessary files, select 
Install Reporting Support Files from the tree-view in the left frame. The files are installed 
automatically when the download completes. 
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Note:
Note: Even if a version of JRE is already installed on your system, you should 

download and install it from Install Reporting Support Files to ensure the 
correct version is installed.

You also must set your preferred time-zone information by selecting User Settings from 
the tree-view. When this is set, all reports will display the date-information according to this 
setting.

To run a report, select the report's name from the tree-view. This action causes an Input 
Page for that report to appear in the right frame. Each Input Page contains a Help button 
you can select to learn more about the input options available for that page.

Note:
Note: Most, but not all, Basic reports have two Input Pages.

Click the right mouse button on a report name to launch an instance of that report in a new 
browser window that does not contain the tree-view frame. You can run multiple reports 
simultaneously by opening another browser window for each report. 

! CAUTION:
CAUTION: OA performance is degraded as more browser windows are opened. Be 

sure to monitor OA performance when running multiple Basic reports.
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Saving a report configuration
This feature allows you to save the input parameters you have entered for a report. This 
lets you avoid having to re-enter information each time you want to generate that report. It 
also allows you to save different versions of the same report with different settings.

Some of the settings you can save this way include input criteria, sorting specifications, 
and water plane settings. Note that this feature saves only the configuration of the report, 
not the data in the report.

To save a report to the My Saved Reports page:

1. From the report page, select Save Report Configuration, select the Save Report 
Configuration icon, select File >Save Report Configuration from the menu, or press 
Ctrl-S. The Save Report Configuration page appears in a new browser window.

Tip:
Tip: To enable short-cut key combinations like Ctrl-S, you must click in the 

button bar area of the report. This shifts the browser "focus" from the report 
area of the browser window to the command area of the window.

2. Enter a unique name in the Report Name field. Report names can be up to 100 
characters long (longer names are truncated at 100 characters). The name you give 
your report should be meaningful enough to help you remember what the report is 
about. Some examples of useful saved report names are: 

● Last week's activity for Advocate service classes

● Last month's activity for all my agents

● Jane Doe's statistics for today 

● Chicago contact center

3. Optionally enter a report description in the Report Description field. The description 
can be up to 500 characters long (longer descriptions are truncated at 500 characters).

The report name and report description you enter on this page are displayed in a table 
on the My Saved Reports page.

4. Select Save Report Configuration.

When the report is saved, you see a confirmation message: Your report configuration 
has been saved. If a report configuration with the same name already exists, you are 
prompted to change the name.

To stop Save Report Configuration and close the browser, select Cancel.
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Troubleshooting a report
When an error occurs that makes it impossible to generate a report, Basic reports display a 
page containing information about the error. Please make a note of the information on the 
error page in case you need to report the problem to your system administrator.

Be careful to avoid setting up invalid combinations such as:

● Invalid date (for example, February 31) in historical report Input Page 1. 

● Start Date and Interval the same as or later than the End Date. 

● �Daily� Aggregation Time Period with Date Range of �Today.� 

● �Weekly� Aggregation Time Period with Date Range of �Today� or �Yesterday� or 
�Week-To-Date.� 

● �Monthly� Aggregation Time Period with Date Range of �Today� or �Yesterday� or 
�Week-To-Date� or �Month-To-Date.� 

● �Monthly� Aggregation Time Period with any Standard date range. 

Certain other problems can cause your report not to appear as you expected. For 
information on how to fix problems with your reports, please refer to Avaya Operational 
Analyst Release 6.1 Maintenance and Troubleshooting.
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User Interface
The section describes features of the user interface for the Basic Reports. The user 
interface consists of: 

● HTML (Web) forms that gather information needed to generate the report (Input 
Pages).

● The generated report, which may be graphical or tabular. Graphical reports use color 
and graphical elements to display statistical information. Tabular reports list report 
elements in a table. Some elements contain hyperlinks to pages that contain expanded 
data.

This section includes the following topics:

● Input pages on page 28

● Graphical report initial display on page 31

● My Saved Reports page on page 32

● Calculations on page 33

● Time and dates on page 34\

● Report fonts and colors on page 37

Input pages
Each report gathers search parameters that define the database queries that retrieve the 
report data. Report Input Pages perform this function. Search parameters are gathered on 
one or more input pages.

This section describes these pages.

Historical reports

Historical reports collect search parameters on two Input Pages. The selections you make 
on Input Page 1 determine the content of Input Page 2 because database information is 
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filtered based on the first input page selections. The following illustrations show typical 
Input Pages for historical reports:

Note:
Note: In Input Page 2 for historical Service Class and Queue reports, queues 

display an additional ID after the item name. Service classes do not display 
the additional ID.
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Real-time reports

Real-time reports use one or two Input Pages. The following illustrations shows examples 
of typical Input Pages for real-time reports. 



User Interface

Issue 1.0 August 2003 31

Selection fields

Selection fields allow you to select one (single-select) or many (multi-select) items. 
Single-select fields display one value with an arrow you can select to display more values. 
Multi-select fields display a list of items, possibly accompanied by a scroll bar and scroll 
arrows when there are too many values to display in a short list.

To select a group of contiguous items from a multi-select field:

● Select the first item.

● Press and hold down Shift and select the last item.

To select a group of non-contiguous items from a multi-select field:

● Press and hold down Control.
● Select each item.

Finish

Select Finish to generate your report using the selections you made on the Input Pages 
for this report.

Restore defaults

The report Input Pages allow you to choose what data to use to create a report, with 
default values already selected. A default value is a setting that will be used if you do not 
specify a preference.

If you make a mistake with your selections and want to start over, select Restore Defaults 
to clear any choices you made on this screen. This action resets all selection fields to their 
default values.

Refresh rate

The refresh rate of a real-time report is independent of the data update rate of the server. 
You can modify the page refresh rate but not the data refresh rate, which is controlled by 
the server and not by individual users. For example: if the data update rate is once every 
minute and the report refresh rate is once every 15 seconds, then the report will refresh at 
least four times before the data in the report will change.

Graphical report initial display 
When a graphical report is displayed for the first time, based on the number of data items 
you selected and the current statistic's title length, some of the graphical items are not 
completely rendered in the first view. 
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For example, if you selected 300 agents over 30 days worth of data and if the graphical 
representation of this report instance is scaled to fit inside a fairly small space, the 
individual items in the display will be scaled very small. In other cases, if you choose only a 
few items, only a part of the floor items are shown in the initial display. 

The report still contains all the items you selected, even though they may not be visible on 
the initial display. You can zoom in or out to move about the report space to view the areas 
you want to focus on. 

In tabular reports containing many data items, you can scroll around the window to view 
report data that does not fit within the window size. The graphical reports behave the same 
way as tabular reports in this sense. Using the key and mouse combinations described 
below, you can explore the three-dimensional space as necessary.

By default, the graphical reports will set the focus of the report to the left center. You can 
move around the report display area to zoom in and zoom out and examine the report 
content of interest to you. By moving around the graphical report space, you can focus on 
a specific region or the entire report content.

● To rotate the graphical components, hold the right mouse button down while moving the 
mouse in the clockwise or counterclockwise direction. 

● To zoom in, press and hold Ctrl and the right mouse button at the same time, and drag 
the mouse from the top of the report toward the bottom of the report. 

● To zoom out, press and hold Ctrl and the right mouse button, and drag the mouse from 
the bottom of the report toward the top of the report. 

My Saved Reports page
The My Saved Reports page contains a list of all your saved report configurations, sorted 
by name. You can launch the report using your saved configuration, or you can delete the 
saved report from the list:

To launch a saved report, select the report you want to generate, then select Launch 
Report. 
To delete a report, select the report you want to delete, then select Delete Saved 
Configuration. 

Note:
Note: This action deletes only your saved configuration. It does not delete the 

original report.
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Calculations
The calculations described here are general to all or most Basic Reports. You can find 
report-specific calculations in Avaya Operational Analyst Release 6.1 Maintenance and 
Troubleshooting.

Average of averages

Many reports, especially historical, allow you to display on one of the walls the average of 
the floor data. When the floor data is an average itself, this can cause some confusion 
about how the calculation is done. The wall title will simply say Average of Average X by Y 
(where X is a statistic such as Number of Work Items Opened and Y is an entity such as 
Queue or Agent).

Most people are used to computing an average by summing a collection of values and 
then dividing by the number of values. In fact, this is how the floor statistics themselves are 
calculated. But when you calculate an average of these averages you need to use a 
different calculation. For example, suppose you had 3 averages displayed on the floor: 3/4, 
1/2, and 1/4 representing the average wait time for a call (and the actual numbers behind 
these results were 75/100, 2/4, 10000/40000 in terms of total wait time divided by number 
of calls). The average of these three values is not simply 3/4 + 1/2 + 1/4 divided by 3 = 1/2. 
That gives far too much importance to the 2/4 data item. Instead, the correct calculation is 
75 + 2 + 10000 divided by 100 + 4 + 40000 = 10077/40104 = 1/4.

Real-time durations

For durations, there are 2 categories. Here are the differences in calculating these cases. 

● Case 1: Given an agent or a queue, how long has this person or item been in the current 
state?

For this, we measure over three data elements. (a) current interval start-time (b) state 
start-time (c) current time (when the data-set was last updated). With these, we apply the 
following function: 

TotalDuration = c - MAX(a, b) 

where MAX() returns the newest timestamp.

● Case 2: Given a particular target state (for example, agent idle, agent on break, service 
class in critical state, and so on), how long has this state been going on? 

For instance, given a particular state, this calculation changes slightly. The data elements 
used here are: (a) current interval start-time, (b) base interval start-time, (c) state 
start-time, (d) current time, and (e) the target column (IdleAvailDur, OnBreakDur, etc.) 
associated with the current interval. 
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Note:
Note: Given the interval type, the query statements will return different columns. 

If you are interested in seeing the idle duration on a particular agent, then the following 
calculation is applied: 

IF (the agent is indeed in Idle state right now) THEN 

durCurrentlyIn = e 

where �e� corresponds to what has been accumulated during the interval if it is base 
interval. If it is daily, it corresponds to the value of what's been accumulated since the start 
of the daily interval until the last base interval. 

ELSE 

durCurrentlyIn = 0 

TotalDuration = [d - MAX(b, c)] + durCurrentlyIn 

Time and dates
This section describes how time and dates are represented in the Basic reports user 
interface.

Current time

Current time in real-time reports is equal to the time stamp of the row of data being 
reported. The time stamp reflects the time of the server where the report subsystem is 
running, which may not be the same as the time of the client machine.

If you set your report to refresh at a rate faster than the rate at which the data set is 
updating, the current time reported may not change, even though the report is refreshed.

Date and time formats

Date and time formats depend on the data contained in the report and, in the case of 
historical reports, the level of data aggregation selected. The format also depends on your 
locale and time-zone settings, which are specified by selecting User Settings in the 
tree-view.

The ordering of date field display is determined by the relevant browser locale and time 
zone settings. For instance, in English, the date field is displayed as month, day, and year, 
but in German, the date field is displayed as day, month and year.
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Date and time elements

In historical reports, the date and time elements displayed are based on the level of data 
aggregation selected on the input pages, as shown in the following table:

Historical report date ranges
Historical Basic reports process date range information differently depending on the Date 
Range and Data Type options you choose on the Input Pages.   For convenience this 
discussion uses the following assumptions:

● The time zone used is Asia/Calcutta (GMT+5:30).

● Date-time information is displayed using JDBC's date-time format (yyyy-mm-dd 
HH:mm). For example, year 2003, month January, day 15, and time 1:23 PM is 
equivalent to 2002-01-15 13:23.

● When a date range is specified from start date to end date, the end date is exclusive 
and not inclusive.

● The current time is always based on the report server's clock.

Standard Date Range

Depending on the Data Type option you choose, the date range you select is interpreted 
differently.

● Half-hour Aggregated and Non-aggregated date range options:

If you choose the Standard date range for either of these Data Type options, the date 
range is determined based on your time zone, from midnight to midnight. For instance, 
if the current date is 2003-01-15 9:35 and you select the Yesterday option for 
Half-hour Aggregated, Today is defined to be from 2003-01-15 00:00 to 2003-01-16 
00:00, and Yesterday is defined to be from 2003-01-14 00:00 to 2003-01-15 00:00.

Data Aggregation Level Time Elements Displayed

Non-Aggregated Year, month, day, and time

Interval Year, month, day, and time

Daily Year, month, and day

Weekly Year, month, and day

Monthly Month and year based on the current user�s locale.
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Note:
Note: The database stores dates in UTC. Before the query is submitted, OA 

converts the date range to UTC, or 2003-01-13 18:30 to 2003-01-14 18:30 
in this example. This reflects that the Asia/Calcutta time zone is 5 hours, 30 
minutes ahead of GMT (GMT+5:30). When the records from a query return, 
OA converts the date range information from UTC to Asia/Calcutta.

Today, Weekly, and Monthly standard options are defined using the same rules 
except that the Weekly option is based on the start of week as administered from the 
Administration Client.

● All other date range options:

For all other aggregated options (archived data such as Daily, Weekly, or Monthly) 
with the Standard date range, the start of day definition is factored into the date range 
determination. Start of day, which is also administered from the Administration Client, 
determines the start and end dates of the range.

For example, assume the current time is 2003-01-15 9:35, you choose the Daily option 
for Yesterday, and that the start of day definition is 18:30 UTC (midnight in 
Asia/Calcutta time zone). OA determines Today using both the current time and the 
start of day values. Since a day begins at 18:30 UTC, and the current time converts to 
2003-01-15 4:05 UTC, Today is determined to be from 2003-01-14 18:30 to 
2003-01-15 18:30, and Yesterday's date range to be from 2003-01-13 18:30 to 
2003-01-14 18:30.   Since the start of day definition happens to match the your time 
zone, this particular date range matches that of the 30-minute interval data options.

Conversely, assume the current time is 2003-01-15 9:35 in Asia/Calcutta time zone, 
the start of day definition is set at 3:30 (UTC), and the same options are chosen as 
before (Daily for Yesterday). In this case, Today is determined to be from 2003-01-15 
3:30 to 2003-01-16 3:30, while Yesterday is from 2003-01-14 3:30 to 2003-01-15 3:30. 
This shows that the 30-minute interval data with the Standard date (Yesterday) does 
not necessarily match the daily-yesterday option if the start of day definition is different 
than your time zone.

! Important:! Important:
Important: You should be aware that such circumstances can exist when comparing 

results for similar date ranges.

Custom Date Range

When using the Custom date range, you explicitly specify the date range start and end 
dates. Other than converting the specified date range from your time zone to UTC, 
historical Basic reports apply no special rules. 

For example, if you specify the Custom date range from 2003-01-10 14:30 to 2003-01-12 
5:00, OA converts that date range to UTC (2003-01-10 9:00 to 2003-01-11 23:30). Then 
OA converts the data returned from this query back to your time zone.
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Report fonts and colors
You may configure the fonts and colors displayed by your Basic reports.

This section includes the following topics:

● Resource bundles on page 37.

● Configuration examples on page 39.

Resource bundles

Basic report configuration information is maintained in files called resource bundles. You 
can change the default font and color configurations by editing the resource file associated 
with a particular report. Before attempting to edit any resource file, consider the following 
constraints:

● You must use a file editor that supports and preserves the UTF-8 file format.

● Do not add white spaces (tabs or blank spaces) at the end of a line you modify. Doing so 
affects report operation.

● Modified resource files are not preserved if you upgrade your reports installation or 
perform the OA repair procedure.

● Any modifications you make are visible to all Basic reports users.

The following table shows the resource files associated with each report or feature.

Report or feature Directory1 File2

Real-time reports

Agent Time in State /set1/rtagtstate RtAgtState_xx.properties

Agent Performance (IC) /set1/rtagtperf RtAgtPerf_xx.properties
RtAgtPerfApplet_xx.properties

Agent Performance by 
Service Class and 
Queue

/set1/rtagtbysvcque RtAgtBySvcQue_xx.properties
RtAgtBySvcQueApplet_xx.properties

Service Class and 
Queue Performance

/set1/rtsvcqueperf RtSvcQuePerf_xx.properties
RtSvcQuePerfApplet_xx.properties

Service Class and 
Queue Status

/set1/rtsvcquestatus RtSvcQueStatus_xx.properties
RtSvcQueStatusApplet_xx.properties

Agent Performance by 
Job

/set4/rtagtbyjob RtAgtByJob_xx.properties
RtAgtByJobApplet_xx.properties
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Job Performance /set4/rtjobperf RtJobPerf_xx.properties
RtJobPerfApplet_xx.properties

Agent Set Outcome 
Codes

/set4/rtagtcompcode RtAgtCompCode_xx.properties

System Set Completion 
Codes

/set4/rtsyscompcode RtSysCompCode_xx.properties

Telephone Number 
States

/set4/rtphonestate RtPhoneState_xx.properties

Historical reports

Agent Performance (IC) /set1/htagtperf HtAgtPerf_xx.properties
HtAgtPerfApplet_xx.properties

Agent Performance by 
Service Class and 
Queue

/set1/htagtbysvcque HtAgtBySvcQue_xx.properties
HtAgtBySvcQueApplet_xx.properties

Service Class and 
Queue Volume

/set1/htsvcvol HtSvcQueVol_xx.properties
HtSvcQueVolApplet_xx.properties

Service Class and 
Queue Performance

/set1/htsvcqueperf HtSvcQuePerf_xx.properties
HtSvcQuePerfApplet_xx.properties

Agent Performance 
(CMS)

/set2/htagtperf HtAgtPerf_xx.properties
HtAgtPerfApplet_xx.properties

Agent Performance by 
Skill

/set2/htagtbyskill HtAgtBySkill_xx.properties
HtAgtBySkillApplet_xx.properties

Skill Performance /set2/htskillperf HtSkillPerf_xx.properties
HtSkillPerfApplet_xx.properties

Agent Performance by 
Job

/set4/htagtbyjob HtAgtByJob_xx.properties
HtAgtByJobApplet_xx.properties

Job Performance /set4/htjobperf HtJobPerf_xx.properties
HtJobPerfApplet_xx.properties

Agent Set Outcome 
Codes

/set4/htagtcompcode HtAgtCompCode_xx.properties

System Set Completion 
Codes

/set4/htsyscompcode HtSysCompCode_xx.properties

Detail reports

CMS Call Detail Reports /set3/calldetail CallDetail_xx.properties

Report or feature Directory1 File2
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Configuration examples

Follow this procedure to change the configuration for Basic report fonts or colors:

1. Locate the resource bundle you wish to modify:

a. Refer the table in Report fonts and colors on page 37 to find the appropriate file for 
the report to be modified.

b. Pre-pend the associated directory name from the table with the root directory that 
contains the resource bundle. The root directory varies according to the platform 
you are using:

and where $OADIR, $WEBDIR, and $WASDIR represent the OA root directory for MS 
Windows, Solaris, and AIX respectively. 

Note:
Note: You may want to verify the directory location with your system administrator.

2. Open the file in a file editor that supports and protects the UTF-8 file format.

3. To modify fonts:

Work Item Detail 
Reports

/set3/wkitem WkItemDetail_xx.properties

Other

Common to server-side 
components

Common ServerSideFonts_xx.properties

Save Reports Feature /set3/savereport SaveReport_xx.properties
1. The full path to the resource bundle directory includes the root directory where OA is installed. This 

path varies, depending on the platform you are using. See Configuration examples on page 39 for 
details.

2. Replace the "xx" in the file name with the 2-letter language name for your locale. For example, use 
"en" for English or "pt" for Portuguese.

Report or feature Directory1 File2

Platform Default root directory

MS Windows $OADIR/stumbras/wepapp/reports1/properties/reports1

Solaris $WEBDIR/webapp/reports1/lib/properties/reports1

AIX $WASDIR/OAReports.ear/stumbras.war/WEB-INF/classes/reports1
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a. Look for a section of the file similar to this:

b. Modify the desired properties.

Note:
Note: Files ending with Applet_xx.properties are related to graphical 

reports. The font sizes in these files are specified in floating points 
understood by the graphics package OA uses. In all other files the font are 
specified in pixel points.

4. To modify colors:

# Wall (left or right plane) Titles
RID_FONT_WALL_TITLE = sans
RID_FONT_SIZE_WALL_TITLE = 1.5
RID_FONT_STYLE_WALL_TITLE = BOLD

# Axis Title
RID_FONT_AXIS_TITLE = sans
RID_FONT_SIZE_AXIS_TITLE = 1
RID_FONT_STYLE_AXIS_TITLE = BOLD

# Left and Right Plane Labels
RID_FONT_WALL_LABEL = sans
RID_FONT_SIZE_WALL_LABEL = 1
RID_FONT_STYLE_WALL_LABEL = BOLD

# Floor Plane Labels
RID_FONT_FLOOR_LABEL = sans
RID_FONT_SIZE_FLOOR_LABEL = 1.5
RID_FONT_STYLE_FLOOR_LABEL = BOLD

# Slider labels
RID_FONT_SLIDER_LABEL = sans
RID_FONT_SIZE_SLIDER_LABEL = 2
RID_FONT_STYLE_SLIDER_LABEL = BOLD
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a. Look for a section of the file similar to this:

b. Modify the desired properties.

Note:
Note: All colors are specified in RGB values.

5. Save the file.

! Important:! Important:
Important: Do not add white spaces (tabs or blank spaces) at the end of a line you 

modify. Doing so affects report operation.

6. Restart the report server.

! Important:! Important:
Important: Old display attributes may continue to appear after changing the resource 

file. If this occurs, be sure to delete all locally cached files from your Web 
browser, close existing browser windows, launch a new browser and run the 
report again.

Item deletion indicator
In real-time and historical report input pages, an asterisk following an item in a selection 
field (for example: agent name* or job name*) indicates that the item was administratively 
deleted from the system.

# Alternating data colors (bar chart, pie chart, label background, 
etc.)
# -- Navy blue
RID_DATA1_R = 50
RID_DATA1_G = 67
RID_DATA1_B = 149
 
# -- gray blue
RID_DATA2_R = 95
RID_DATA2_G = 138
RID_DATA2_B = 197
 
# -- aqua green
RID_DATA3_R = 106
RID_DATA3_G = 187
RID_DATA3_B = 175
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Note:
Note: In real-time reports the indicator identifies a pending physical deletion of the 

item from the database. In historical reports the records associated with the 
indicated item are retained over time.

You can change the default deleted symbol (*) to some other character or characters. To 
change the symbol, modify the label associated with identifier RID_DELETED_SYMBOL 
or RID_DELETED in the resource bundle associated with the relevant report. See Report 
fonts and colors on page 37 for more information on modifying resource bundles.
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Predefined reports
OA R6.1 includes the following predefined Basic reports.

Note:
Note: For most reports you can customize the input criteria and some report 

settings, then save those configurations for later use. See Saving a report 
configuration on page 26 for details.

..

Real-time Report Name Report Description

Service Class and Queue Status This report keeps you informed of the 
performance of a Service Class or Queue

Service Class and Queue Performance This report allows you to compare statistics 
among Service Classes and Queues.

Agent Time in State This report allows you to identify all agents 
in a particular state.

Agent Performance This report provides a way to compare one 
or more statistics among selected agents.

Agent Performance by Service Class and 
Queue

This report allows comparison of agents 
across Service Classes and Queues.

Agent Performance by Job This report provides a real-time view of how 
agents are performing with respect to the 
kind of outbound work that they are asked 
to do.

Agent Set Outcome Codes This report provides a real-time view of the 
outcome codes being assigned to particular 
jobs by agents.

Job Performance This report provides a real-time view of the 
performance of your outbound jobs.

System Set Completion Codes This report provides a real-time view of 
what is happening to call attempts 
associated with a set of jobs.

Telephone Number States This report provides a real-time view of how 
many telephone numbers are in a particular 
state for a set of jobs.
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Historical Report Name Report Description

Agent Performance by Service Class and 
Queue

This report allows historical comparison of 
agents within different Service Classes and 
Queues.

IC Agent Performance This report provides a way to compare a 
statistic among selected agents.

Service Class and Queue Performance This report allows you to compare statistics 
among Service Classes and Queues.

Service Class and Queue Volume This report provides a way to assess 
whether more work is arriving than is being 
handled. This allows you to compare 
service classes and queues to see where 
obstructions are occurring.

Agent Performance by Skill This report allows historical comparison of 
agents within different skills

Skill Performance This report allows you to compare statistics 
among Skills.

CMS Agent Performance This report provides a way to compare a 
statistic among selected agents

Agent Performance by Job This report provides an historical view of 
the performance of outbound agents over a 
period of time.

Agent Set Outcome Codes This report provides an historical view of 
the outcomes assigned by agents to 
outbound calls over a period of time.

Job Performance This report provides an historical view of 
outbound job performance over a period of 
time.

System Set Completion Codes This report provides an historical view of 
what happens to call attempts over a 
period of time.
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Detail Report Name Report Description

CMS Call Detail This set of drill-down reports presents 
CMS Call History data to show the "cradle 
to grave" history of a customer contact.

Work Item Detail This set of drill-down reports integrates IC 
Repository Work Item data and CMS Call 
History data to show the 
"beginning-to-end" history of a customer 
contact.
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Report descriptions
This section describes each of the available Basic reports.

This section includes the following topics:

● Historical Agent Performance by Service Class and Queue on page 47

● Historical IC Agent Performance on page 49

● Historical Service Class and Queue Performance on page 50

● Historical Service Class and Queue Volume on page 52

● Real-time Agent Performance by Service Class and Queue on page 53

● Real-time Agent Performance on page 55

● Real-time Agent Time in State on page 56

● Real-time Service Class and Queue Performance on page 57

● Real-time Service Class and Queue Status on page 58

● Historical Agent Performance by Skill on page 60

● Historical CMS Agent Performance on page 61

● Historical Skill Performance on page 63

● CMS Call Detail on page 64

● Segment Information on page 66

● Call Work Codes on page 67

● Work Item Detail on page 68

● Segment Information on page 70

● Wrap-Up Codes on page 71

● Historical Agent Performance by Job on page 72

● Historical Agent Set Outcome Codes on page 74

● Historical Job Performance on page 75

● Historical System Set Completion Codes on page 76

● Real-time Agent Performance by Job on page 77

● Real-time Agent Set Outcome Codes on page 79

● Real-time Job Performance on page 80

● Real-time Telephone Number States on page 81

● Real-time System Set Completion Codes on page 82
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Historical Agent Performance by Service Class and Queue

Report overview

The Historical Agent Performance by Service Class and Queue report provides an 
historical view of multiple agents and a single Service Class or Queue, or multiple Service 
Classes and Queues and a single agent, over time. An agent�s performance can be 
compared to other agents working in the same service class or queue, or a single agent�s 
performance can be compared when working in several service classes and queues. The 
source of the data is the containers in which OA stores historical data or the 
non-aggregated interval data.

In this report, you can display:

● Average Work Duration

● Average Wrap-Up Duration

● Number of Work Items Opened

● Number of Work Items Completed

● Average Customer Hold Duration

● Average Deferred Duration



Basic Reports

48 Operational Analyst R6.1 Reports Reference

Data layout

The floor of the Historical Agent Performance by Service Class and Queue report displays 
absolute or average Agent performance data over time for the selected Agents or Service 
Classes and Queues, as chosen from the Floor menu.

Note:
Note: Agent(s) may not be associated with a Service Class, resulting in empty 

rows in the report. This is not the same as having a zero value.

The left and right walls display either average or total data for the floor data, as determined 
by the item selected from the respective Wall menu. The left wall shows floor data 
summarized by Agent or Service Class and Queue, over time, while the right wall shows 
floor data summarized across the displayed Agents, or Service Classes and Queues, for a 
given time period.

Note:
Note: The statistic selected for the floor and the statistic available for the walls are 

related. For example, if you select average data for the floor, only average 
data may be selected for the walls.

Analyzing the report

This report answers the business question "How do agents within service classes and 
queues compare to each other historically?"
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Historical IC Agent Performance

Report overview

The Historical Agent Performance report provides historical views of agent performance, 
allowing trend-based comparison of agents based on historical data. The source of the 
data is the containers in which OA stores historical data or the non-aggregated interval 
data.

In this report, you can display:

● Number of Work Items Completed

● Number of Work Items Opened

● Average Work Duration

● Average Wrap-Up Duration

Data layout

The floor of the Historical Agent Performance report displays absolute or average Agent 
performance data over time for the selected Agents, as chosen from the Floor menu.
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The left and right walls display either average or total data for the floor data, as determined 
by the item selected from the respective Wall menu. The left wall shows floor data 
summarized by Agent over time, while the right wall shows floor data summarized across 
the displayed Agents for a given time period.

Note:
Note: The statistic selected for the floor and the statistic available for the walls are 

related. For example, if you select average data for the floor, only average 
data may be selected for the walls.

Pausing the mouse cursor on a bar, column or label causes information about that element 
to be displayed.

Analyzing the report

This report answers the business question "Which Agents were most productive over a 
specified period of time?"

Historical Service Class and Queue Performance
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Report overview

The Historical Service Class and Queue Performance report provides historical views of 
Service Class and Queue performance, allowing trend-based comparison of work item 
counts and average durations. The source of the data is the containers in which OA stores 
historical data or the non-aggregated interval data.

In this report, you can display count and average-duration statistics for:

● Percentage of Work Items Handled Within Service Level

● Number of Work Items Offered

● Number of Work Items Completed

● Number of Abandoned Work Items

● Average Wait Time

● Average Time to Abandon

Data layout

The floor of the Historical Service Class and Queue Performance report displays absolute 
numbers of items or average numbers of items for the selected Service Classes and 
Queues, as chosen from the Floor menu.

The left and right walls display either average or total data for the floor data, as determined 
by the item selected from the respective Wall menu. The left wall shows floor data 
summarized by Service Class and Queue over time, while the right wall shows floor data 
summarized across the displayed Service Classes and Queues for a given time period.

Note:
Note: The statistic selected for the floor and the statistic available for the walls are 

related. For example, if you select average data for the floor, only average 
data may be selected for the walls.

Pausing the mouse cursor on a bar, column or label causes information about that element 
to be displayed.

Analyzing the report

This report answers the business questions:

● Am I losing customers because they have to wait too long?

● Which Service Class or Queue had the greatest or least number of Work Items opened 
last week or last month?
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Historical Service Class and Queue Volume

Report overview

Service Class and Queue Volume is a graphical historical report that provides a way to 
assess where the obstructions are in your processes. This report allows you to identify 
trends and patterns in the data by:

● Comparing new work items to departed work items by Service Class and Queue. 

● Showing average wait time for Service Classes and Queues.

● Showing average wait time across all Service Classes and Queues for each time period.

You specify a set of Service Classes and Queues and a time period. The time period is the 
interval of time over which data has been collected. All Service Classes and Queues 
display data for the same time interval. The source of the data is the containers in which 
OA stores historical data or the non-aggregated interval data.

Data layout

The report floor shows new work items offered versus completed work items for each 
Service Class and Queue. 
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The left wall shows the Average Wait Time for Service Classes and Queues over the 
selected time period. 

The right wall shows the Average Wait Time across all Service Classes and Queues for 
each time period displayed on the "time" axis.

Pausing the mouse cursor on a bar, column or label causes information about that element 
to be displayed.

Analyzing the report

This report answers the business question "Where are the obstructions in my work flow?"

Real-time Agent Performance by Service Class and Queue

Report overview

The Real-Time Agent Performance by Service Class and Queue report provides an 
operational view of multiple agents across multiple service classes and queues. An agent�s 
performance can be compared to other agents working in the same service class and 
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queue, or to that same agent�s performance when working in other service classes and 
queues.

In this report, you can display:

● Average Work Duration

● Average Wrap-Up Duration

● Number of Work Items Opened

● Number of Work Items Completed

● Average Customer Hold Duration

● Average Deferred Duration

Analyzing the report

This report answers the business questions:

● How well does an agent perform in each of his or her service classes and queues?

● How does an agent compare to other agents in the same service class or queue?

● How does an agent's work vary across several service classes and queues?
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Real-time Agent Performance

Report overview

The Agent Performance report provides a view of individual agent work performance in 
real-time. An agent's performance numbers can either be compared to absolute targets or 
compared with other agents.

In this report, you can display:

● Number of Work Items that the agent currently has open

● Average amount of time the agent has spent working on items

● Average amount of time the agent has spent wrapping up work

● Amount of time the agent spent in the idle state while available during this interval

● Amount of time the agent has spent on break during this interval

Analyzing the report

This report answers the business questions:

● How do my agents compare with each other?
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● Which agents excel in specific areas?

● What agents are not measuring up in specific areas?

Real-time Agent Time in State

Report overview

The Agent Time in State report is a tabular real-time report that can be launched either 
from the reports tree-view or by clicking on a slice of a pie chart in the Service Class and 
Queue Status report. You can use this report to determine what state Agents are in, how 
long they have been in that state, what their role is relative to a Service Class, and whether 
they can be used to support other Service Classes or Queues.

Layout

The Agent Time in State report contains columns named: Agent, State, Availability, Time 
in State, Time in Focus, Service Class, Queue, Job, and Role. Various combinations of 
columns appear depending on the values selected on the input pages.
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Analyzing the report

This report answers the business questions:

● Who is in the best position to help me bring this service class or queue back into 
acceptable service levels?

● How long has a particular set of agents been in its current state and what is that state?

Real-time Service Class and Queue Performance

Report overview

The goal of this report is to inform you about the performance of Service Classes and 
Queues currently and over the last 30 minutes. The Service Class and Queue Status 
report lets you view Real-Time performance data for each Service Class and Queue you 
specify.

The Service Class and Queue Performance Real-time report provides a real-time view of 
how service classes and queues are performing on the basis of a statistic you select. 
Service class and queue performance can be compared either to absolute targets or to 
other service classes and queues.
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In this report, you can display:

● Percentage of Work Items Handled Within Service Level

● Number of Work Items in Queue

● Number of Work Items Offered

● Number of Work Items Completed

● Number of Abandoned Work Items

● Latest Average Wait Time

● Average Time to Abandon

● Percentage of Matched Work Items

Analyzing the report

This report answers the business question "Which Service Classes or Queues stand out, 
in either a good way or a bad way?"

Real-time Service Class and Queue Status
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Report overview

The purpose of this report is to keep you informed about the performance of Service 
Classes and Queues currently and over the last 30 minutes. The Service Class and Queue 
Status report lets you view real- time performance data for each Service Class and Queue 
you select.

Data layout

Floor: The data displayed on the floor is determined by your selection from the 
Floor/Statistic menu. The graphic representation is determined by your selection from the 
Floor/Display As menu.

Left Wall: The data displayed as a vertical bar on the left wall is determined by your 
selection from the Left Wall menu.

Right Wall: The right wall appears when a Service Class label on the x-axis is selected. 
The right wall displays pie charts representing Agent Roles assigned to the Service Class, 
subdivided to show numbers of Agents in a particular state.

Analyzing the report

This report answers the business questions:

● Which Service Classes and Queues are in trouble?

● Which Service Classes and Queues are in trouble over a period of time?

● How long will a customer wait in queue before their questions are answered (Expected 
Wait Time)?

When a Service Class or Queue is in trouble, the Service Class and Queue Status report 
visually alerts you to the problem. For Service Classes, you can identify specific agents 
who are available to help a Service Class that is performing below the desired service 
levels. You can identify those agents by following links to the Agent Time in State real time 
report.

The floor of the report displays the performance trend of a Service Class or Queue over a 
30-minute interval. The trending information displayed on the floor allows you to determine 
which Service Classes or Queues are in trouble, and how long the Service Class or Queue 
performance has been deteriorating or improving over a period of time. The left wall 
includes the total number of queued work items and expected wait time. For Service 
Classes, the right wall displays agent state information using a series of pie charts. Agent 
state information is organized by agent role. The right wall is only displayed when a single 
Service Class is selected, hiding all other Service Classes and Queues.

Pausing the mouse cursor on a label, bar, or pie slice causes information about that 
element to be displayed.
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Historical Agent Performance by Skill

Report overview

The Historical Agent Performance by Skill report provides an historical view of multiple 
agents and a single Skill, or multiple Skills and a single agent, over time. An agent�s 
performance can be compared to the performance of other agents working in the same 
Skill, or a single agent�s performance can be compared when working in several Skills. The 
source of the data is the containers in which OA stores historical data or the 
non-aggregated interval data.

In this report, you can display:

● Number of ACD Calls

● Average ACD Duration

● Average ACW Duration

Analyzing the report

This report answers the business question "How do agents with the same skills compare to 
each other historically?"
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The floor of the Historical Agent Performance by Skill report displays absolute or average 
Agent performance data over time for the selected Agents or Skills, as chosen from the 
Floor menu.

Note:
Note: An Agent may not be associated with a Skill, resulting in an empty row in the 

report. This is not the same as having a zero value.

The left and right walls display either average or total data for the floor data, as determined 
by the item selected from the respective Wall menu. The left wall shows floor data 
summarized by Agent or Skill over time, while the right wall shows floor data summarized 
across the displayed Agents or Skills for a given time period.

Note:
Note: The statistic selected for the floor and the statistic available for the walls are 

related. For example, if you select average data for the floor, only average 
data may be selected for the walls.

Pausing the mouse cursor on a bar, column or label causes information about that element 
to be displayed.

Historical CMS Agent Performance
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Report overview

The CMS Agent Performance report provides historical views of agent performance, 
allowing trend-based comparison of agents based on historical CMS data. The source of 
the data is the containers in which OA stores historical data or the non-aggregated interval 
data.

In this report, you can display:

● Number of ACD Calls

● Average ACD Duration

● Average ACW Duration

Analyzing the report

This report answers the business question "Which Agents were most productive over a 
specified period of time?"

The CMS Agent Performance report presentations a floor and two walls. You select which 
agents you would like to include in the report. The statistical data is displayed using 
three-dimensional columns that rise from the floor, with the value of the column 
representing the value of the statistic. Time extends from most recent to oldest along the 
"time" axis. The left and right walls summarize the data presented on the floor.

Pausing the mouse cursor on a bar, column or label causes information about that element 
to be displayed.
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Historical Skill Performance

Report overview

The Skill Performance historical report provides historical views of Skill performance, 
allowing trend-based comparison of call counts and average durations. The source of data 
for this report is the containers in which OA stores historical data.

In this report, you can display count and average-duration statistics for:

● Number of ACD Calls

● Average Speed of Answer

● Number of Abandoned Calls

● Average Time to Abandon

Analyzing the report

This report answers the business questions:

● Am I losing customers because they have to wait too long?
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● Which Skills had the greatest or least number of Work Items opened last week or last 
month?

Pausing the mouse cursor on a bar, column or label causes information about that element 
to be displayed.

CMS Call Detail

Report overview

The CMS Call Detail reports consist of a CMS Call Detail report, a Segment Information 
report, and a Call Work Codes report. The reports act as a hierarchy with Call Detail 
reports displaying multiple calls, each with a corresponding Segment Information report. 
The Segment Information reports list multiple segments for a particular Call with each 
segment potentially having a corresponding Call Work Codes report. The Call Work Codes 
reports list multiple work codes for a particular Call segment.

This set of reports provide a "cradle-to-grave" record of all relevant segments of a given 
call.
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This set of Call Detail reports answers the business questions: 

● What was the customer experience when contacting my center? 

● How many times was a call of a particular type put on hold? 

● How long did the call wait in queue?

● What was the beginning-to-end history of a call?

● What Call Work Codes were used for this call?

Analyzing the report

The CMS Call Detail report displays columns labeled: Date, To, From, and Data Source. 
The To field displays the phone number of the Agent handling the first segment of the call. 
The From field displays the phone number of the person initiating the call.

To launch the Segment Information Report for a call select the single magnifying glass 
icon. 

To launch the Call Work Codes report for a call, select the double magnifying glass icon. 
The Call Work Codes report then displays all codes accumulated over the entire life of the 
call. 

Note:
Note: In cases where a call involves multiple switches, the call will appear in this 

report once for each switch involved. Drilling down to the Segment 
Information report from any of these rows will produce the same, complete 
Segment Information.
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Segment Information

Report overview

The Segment Information report presents information about the set of call segments 
associated with a call. The life cycle of a call is composed of call segments, each 
representing time spent on the call while interacting with an Agent. Each row of the report 
represents a segment of the selected call.

This report is reached by drilling down from the CMS Call Detail report. To drill down to a 
segment report from a call detail report, select the single magnifying glass to the left of any 
call. 

Note:
Note: You cannot save a custom configuration for reports that are subsets of other 

reports.

Data layout

The Segment Information Report is a tabular report that contains rows of data that identify 
the details of each segment. Columns in the table are labeled: Agent, Skill, VDN, Wait 
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Time, Times Held, Hold Time, Talk Time, ACW Time, Duration, Disposition and Data 
Source. The header of the report identifies the call being reported on. A double magnifying 
glass icon is displayed to the left of any row that has a Call Work Codes report associated 
with a call segment in that row. 

Note:
Note: The Duration field is the combination of Agent�s work time and wrap-up 

time. It does not include the time the customer spent in queue waiting to be 
served.

The table is sorted in chronological order, with the oldest segment at the top of the table 
and the most recent segment at the bottom. No further sorting is allowed.

Analyzing the report

To launch the associated Call Work Codes report in a separate browser window, select the 
double magnifying glass icon.

Call Work Codes
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Report overview

The Call Work Codes report shows information about the call work codes (up to 6) that 
were entered by agents for that segment of the call. This report is reached as a drill down 
from the Segment Information report or as a drill down from the CMS Call Detail report.

Data layout

This report displays data for a single segment of a single call or all segments of a single 
call, depending on how the report was reached. 

Note:
Note: You cannot save a custom configuration for reports that are subsets of other 

reports.

Work Item Detail
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Report overview

The Work Item Detail reports consist of a Work Item Detail report, a Segment Information 
report, and a Wrap-Up Codes report. The reports act as a hierarchy with Work Item Detail 
reports displaying multiple work items, each with a corresponding Segment Information 
report. The Segment Information reports list multiple segments for a particular work item - 
with each segment having a corresponding Wrap-Up Codes report. The Wrap-Up Codes 
reports list multiple tasks for a particular work item segment.

This set of reports provide a "cradle-to-grave" record of all relevant segments of a work 
item.

The entries in the To and From fields relate to the telephone number or address of the 
Agent handling the contact or the party initiating the contact, respectively, depending on 
the channel of the contact.

Data layout

The Work Item Detail report displays a table with columns labeled: Date, Time in System, 
Number of Times Handled, and Number of Times Held or Deferred. (These columns 
correspond to the fields on the Input Page.) Icons displayed to the left of each row 
represent links to more detailed data:

● Select the single magnifying glass icon to launch the associated Segment Information 
report.

● Select the double magnifying glass icon to launch the associated Wrap-Up Codes 
report.

Analyzing the report

This report answers the business questions:

● What was the customer experience when contacting my center?

● How many times on the average was a work item of a particular type handled, deferred, 
or put on hold?
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Segment Information

Report overview

The Segment Information report presents information about the list of process segments 
associated with a work item. The life cycle of a work item is composed of a series of 
process segments, each representing time spent on the work item while interacting with an 
Agent.

This report displays data for a single work Item and may be reached only by drilling down 
from the Work Item Detail report.

Data layout

The Segment Information report is a tabular report that contains rows of data that identify 
the details of each segment. Columns in the table are labeled: Agent, Queue or Skill, 
From, To, Channel, and Duration. The header of the report identifies the Work Item being 
reported on. A magnifying glass icon is displayed to the left of any row that has a Wrap-Up 
Codes report associated with it. Rows representing automated interactions do not have 
associated Wrap-Up Codes reports.

The table is sorted with the oldest segment at the top of the table and the most recent 
segment at the bottom. No further sorting is allowed.
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Analyzing the report

Select the double magnifying glass icon to launch the associated Wrap-Up Codes report in 
a separate browser window.

Wrap-Up Codes

Report overview

The Wrap-Up Codes report shows information about the Category, Reason, and 
Outcome codes that were entered by agents when they completed their work. Wrap-Up 
Codes reports are associated only with Routing Event segments, not with CMS Call 
History segments.

This report displays data for a single segment of a single work item and can be reached 
only by drilling down from the Segment Information report or from the Work Item Detail 
report.
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Analyzing the report

Rows are sorted with all Category codes first, then all Reason codes, then all Outcome 
codes. Within a set of codes, the codes are sorted by code number. No further sorting of 
rows is supported for this report.

Historical Agent Performance by Job

Report overview

The Historical Agent Performance by Job report provides an historical view of multiple 
agents and a single job, or multiple jobs and a single agent, over time. This allows you to 
compare agent�s performance to other agents working in the same job, or a single agent�s 
performance over several job categories. The source of the data is the containers in which 
OA stores historical data or the non-aggregated interval data.

You can select any one of the following statistics to display:

● Average Work Duration

● Average Wrap-Up Duration
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● Total Work Duration

● Total Wrap-Up Duration

● Average Preview Duration

● Number of Work Items Completed

● Number of Work Items Rejected

● Number of Work Items Previewed

The floor of the Historical Agent Performance by Job report displays absolute or average 
Agent performance data over time for the selected Agents or Jobs, as chosen from the 
Floor menu.

Note:
Note: One or more Agents may not be associated with a selected Job, resulting in 

an empty row in the report. This is not the same as having a zero value.

The left and right walls display either average or total data for the floor data, as determined 
by the item selected from the respective Wall menu. The left wall shows floor data 
summarized by Agent, or Job, over time, while the right wall shows floor data summarized 
across the displayed Agents, or Jobs, for a given time period.

Note:
Note: The statistic selected for the floor and the statistic available for the walls are 

related. For example, if you select average data for the floor, only average 
data may be selected for the walls.

Analyzing the report

You can determine an Agent�s strengths and weaknesses by comparing performance over 
a number of jobs. Also, you can determine which of a number of Agents performs a 
particular job most efficiently. This information can be useful while balancing the work load 
in your contact center.
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Historical Agent Set Outcome Codes

Report overview

The Historical Agent Set Outcome Codes report provides an historical view of the 
distribution of outcome codes applied to specific jobs by specific agents over time. Any 
outcome codes not selected in the report input page are summed and reported together. 
The source of the data is the containers in which OA stores historical data or the 
non-aggregated interval data.

Analyzing the report

The data in this report can help you determine:

● Which jobs have the most successful outcomes and at what particular times?

● What is the best time of day to call for a particular job?
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Historical Job Performance

Report overview

The Job Performance report provides historical views of Job performance, allowing 
trend-based comparison of work item counts and average durations. The source of the 
data is the containers in which OA stores historical data or the non-aggregated interval 
data.

In this report, you can display count and average-duration statistics for:

● Hit Rate

● Number of Work Items Completed

● Nuisance Call Rate

● Number of Nuisance Calls

● Number of Telephone Numbers Unreachable

● Maximum Number of Agents Subscribed

● Number of Telephone Numbers Loaded

The floor of the Job Performance report displays statistics for the selected Jobs, as chosen 
from the Floor menu.
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The left and right walls display either average or total data for the floor data, as determined 
by the item selected from the respective Wall menu. The left wall shows floor data 
summarized by Job over time, while the right wall shows floor data summarized across the 
displayed Jobs for a given time period.

Note:
Note: The statistic selected for the floor and the statistic available for the walls are 

related. For example, if you select average data for the floor, only average 
data may be selected for the walls.

Analyzing the report

This report provides data that indicate trends about any particular Jobs. For example, you 
could easily determine:

● Jobs with a historical trend with regard to hit rate or nuisance calls.

● Relationships between time of day and call rate.

Historical System Set Completion Codes
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Report overview

The Historical System Set Completion Codes report provides an historical view of the 
results of call attempts over time. Any completion codes not selected in the report input 
page are summed and reported together. The source of the data is the containers in which 
OA stores historical data or the non-aggregated interval data.

Analyzing the report

The data in this report can help you determine:

● What time of day is most likely to result in a call to an answering machine?

● What time of day is most likely to result in a nuisance call?

Real-time Agent Performance by Job

Report overview

The real-time Agent Performance by Job report provides an operational view of multiple 
agents across multiple jobs. This allows you to compare agent�s performance to other 
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agents working in the same job, or a single agent�s performance over several job 
categories.

You can select any one of the following statistics to display:

● Average Work Duration

● Average Wrap-Up Duration

● Total Work Duration

● Total Wrap-Up Duration

● Number of Work Items Completed

● Number of Work Items Rejected

● Number of Work Items Previewed

The floor of the Real-time Agent Performance by Job report displays the value for a 
statistic, chosen from the Floor menu, for a given Agent and a given Job.

Note:
Note: If an Agent is not associated with a selected Job, the result is an empty spot 

in the floor. This is not the same as having a zero value.

The left and right walls display either average or total data for the floor data, as determined 
by the item selected from the respective Wall menu. The left wall shows floor data 
summarized by Agent, while the right wall shows floor data summarized across the 
displayed Jobs.

Note:
Note: The statistic selected for the floor and the statistic available for the walls are 

related. For example, if you select average data for the floor, only average 
data may be selected for the walls.

Analyzing the report

The data provided by this report can help you determine situations like:

● Which Agent is taking the longest to perform a particular job.

● Who is most efficient at call wrap-up.

● Whether Agents are spending more time in preview or wrap-up for a particular job.
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Real-time Agent Set Outcome Codes

Report overview

The real-time Agent Set Outcome Codes report provides an operational view of the 
distribution of outcome codes applied to specific jobs by specific agents for the current 
interval. Any outcome codes not selected in the report input page are summed and 
reported together.

Analyzing the report

The data in this report can help you determine:

● How are jobs performing with respect to the number and kind of outcomes that they are 
experiencing?

● Which agents are more effective in achieving successful outcomes?
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Real-time Job Performance

Report overview

The real-time Job Performance report provides an operational view of how jobs are 
performing on the basis of a selected statistic. Performance can be compared to absolute 
targets or other jobs.

In this report, you can display:

● Hit Rate

● Average Work Duration

● Average Wrap-Up Duration

● Nuisance Call Rate

Analyzing the report

The data in this report can indicate if a particular job is experiencing more than a normal or 
target hit rate or call rate. It can also help identify jobs that are currently taking more or less 
time than expected.
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Real-time Telephone Number States

Report overview

The Telephone Number States report provides a real-time view of how many telephone 
numbers are in a particular state for a set of jobs. Any states not selected in the report input 
page are summed and reported together.

Analyzing the report

The data in this report can help you determine:

● How many telephone numbers are considered unreachable for this job?

● How many telephone numbers are scheduled for a call back?
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Real-time System Set Completion Codes

Report overview

The real-time System Set Completion Codes report provides an operational view of the 
results of call attempts in the current interval. Any completion codes not selected in the 
report input page are summed and reported together.

Analyzing the report

The data in this report can help you determine:

● How many calls are reaching answering machines?

● How many nuisance calls have occurred for each job?
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Advanced reports

This section provides information you need to effectively apply the tools offered through 
Operational Analyst Advanced Reports.

This section includes the following topics:

● General information on page 84

● Cube descriptions on page 91

● Report descriptions on page 99

● Multidimensional cubes on page 111
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General information
Advanced Reports must be installed correctly before you can use the tools.

This section includes the following topics:

● Installation path on page 84

● Default directory locations on page 85

● Database client libraries on page 86

● Database definition on page 87

● Database access on page 90

Installation path
Advanced Reports can be installed only on C:\Program Files\Avaya\Bi. Cognos 
reports and cubes reference supporting files by hard coded absolute paths in the reports 
and cubes. Because reports and cubes are stored as binary files, they cannot be modified 
during installation, meaning that Advanced Reports cannot be installed in a variable 
location. 

If you attempt to change the default directory during installation, the installation program 
will exit with an error message. Avaya further recommends installing Advanced Reports on 
a client machine rather than on the OA server, to avoid using excessive disk space on the 
server's �C� drive. 

There are at least three types of files that reference supporting files by their absolute paths:

● All Impromptu Reports (*.imr and *.iqd files) hard code the paths of the Catalogs 
(*.cat) they use to access the database. Multiple Impromptu Reports point to one 
Catalog and typically there is one Catalog for each database (e.g., one for repository, 
one for ccq, etc.). Also, all Impromptu Reports reference the Avaya logo (avaya.bmp) 
using an absolute path.

● All Model Files (*.mdl files) hard code the paths of the data sources (*.iqd). Data 
sources are queries to define the input data for building Cubes.

● All PowerPlay Reports (*.ppr and *.ppx files) hard code the paths of the 
PowerCubes (*.mdc). PowerPlay Reports are essentially different views of a 
PowerCube, organized along different dimension and measures.
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Default directory locations
The default directory locations for various Advanced Reports components are:

● Cognos Impromptu files: 
Program Files\Avaya\BI\reports\cognos\Impromptu. This folder contains 
five folders:

- CallCenterQ

- CustQ

- HrQ

- qrepository

- oadb

Each of these five folders represents an application and contain:

● A catalog (CAT) file for the respective application. 

● Impromptu (IMR) reports and supporting files.

CallCenterQ and qrespository folders contain:

● Hotfiles that specify time ranges for viewing data.

● Impromptu reports for drilling through from the contacts, tasks, and CallCenterQ 
cubes.

oadb folder contains:

● Hotfiles that specify time ranges for viewing data.

● Cognos Impromptu files for Chinese, Japanese, or Korean language reports: 
Program Files\Avaya\BI\reports\cognos\Impromptu_intl. This folder 
contains the same folders and files as 
Program Files\Avaya\BI\reports\cognos\Impromptu except that the files 
are built using Impromptu 6.1. To make the files in this folder available to Cognos:

- Rename Program Files\Avaya\BI\reports\cognos\Inpromptu to 
Program Files\Avaya\BI\reports\cognos\Impromptu_ver7.

- Rename Program Files\Avaya\BI\reports\cognos\Impromptu_intl to 
Program Files\Avaya\BI\reports\cognos\Inpromptu.

● PowerPlay files: Program Files\Avaya\BI\reports\cognos\PowerPlay. This 
folder contains five folders:

- CallCenterQ

- qrepository

- tasks

- cms



Advanced reports

86 Operational Analyst R6.1 Reports Reference

- mma

Each of these folders correspond to PowerPlay reports for viewing the cube. The 
default cube is generated in this directory.

● All Impromptu files associated with the cubes and the cubes themselves: Program 
Files\Avaya\BI\reports\cognos\cubes. This folder contains five folders, one 
for each cube:

- CallCenterQ

- contact

- tasks

- cms

- mma

Each of the five folders contain:

● The Model file (MDL) that can be used to generate the corresponding cube using 
Transformer.

● The Impromptu (IMR) reports and their corresponding query definition (IQD) files for 
defining the data sources for the corresponding cube.

● All Impromptu files associated with the cubes and the cubes themselves for Chinese, 
Japanese, or Korean language reports: 
Program Files\Avaya\BI\reports\cognos\cubes_intl. This folder contains 
the same folders and files as Program Files\Avaya\BI\reports\cognos\cubes 
except that the files are built using Impromptu 6.1. To make the files in this folder 
available to Cognos:

- Rename Program Files\Avaya\BI\reports\cognos\cubes to Program 
Files\Avaya\BI\reports\cognos\cubes_ver7.

- Rename Program Files\Avaya\BI\reports\cognos\cubes_intl to 
Program Files\Avaya\BI\reports\cognos\cubes.

Database client libraries
Database client libraries are required to run Advanced Reports. These libraries must be 
installed on the same machine where Impromptu and Transformer are run and on any 
machine where drill-through capability is required. 
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Database definition
After installing Advanced Reporting, you must define logical databases for Advanced 
Reports in Impromptu Administrator. The default logical database names for Advanced 
Reports provided with OA R6.1 are:

Tip:
Tip: For more detailed instructions on defining your database, refer to Cognos 

Impromptu Administrator�s Guide.

To define your database:

1. In Impromptu Administrator, select Catalog > Databases.

2. Select your database type from the list and select New Database. 

3. Complete the fields in the Database Definition dialog box using the logical database 
names in the previous table to specify the exact connectivity information. 

4. Select OK.

Note:
Note: "oadb" accesses the Repository application through the database 

views/synonyms. You must refresh (that is, remove and re-create) the 
database views/synonyms if the Repository schema is changed. Then you 
must update the catalog file.

Changing the Advanced Reports catalog database names
If your database names differ from repository, ccq, customerq, hrq, or oadb then 
you must change Advanced Reports catalog database names in Impromptu Administrator.

Application Logical database name

CallCenterQ ccq

HrQ hrq

CustomerQ customerq

Repository repository

CMS oadb

Contact Segment oadb
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The following example illustrates how to change the logical database name from 
"repository" to "icdb:"

1. Open your Advanced Reports catalog in Impromptu Administrator using the default 
logical database name.

2. Select Catalog > Tables. 
The Tables dialog box appears.

3. Select the database, repository, in the Catalog Tables field.
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4. Select Rename to open the Rename Catalog Component dialog box.

5. Enter the new logical database name, icdb, in the Name field of the Rename Catalog 
Component dialog box, and select OK.

6. Double click the new logical database name, icdb.

7. Select the repository entry under icdb.

8. Select Rename to open the Rename Catalog Component dialog box.

9. Enter the new name, icdb, in the Name field of the Rename Catalog Component 
dialog box, and select OK.
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10. Select OK in the Catalog Tables dialog box to rename the database and catalog.

11. Create the new database connection. See Database definition on page 87 for details.

12. Delete the old repository database connection.

13. Regenerate the IQD files:

a. Open the Predefined, Detailed, Drill-Through Reports in the cognos\cubes 
directory in Impromptu Administrator.

b. Save the reports as file type IQD.

Database access
All Impromptu reports prompt you for the date ranges of the data you want to see. The 
report�s performance depends on the date range specified in your query. The larger the 
date range specified, the longer it takes for Impromptu to generate the report data.

All Impromptu and PowerPlay reports read the data directly from the database. For this 
reason, times shown in the reports are GMT, not the local client time.
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Cube descriptions
This section describes the predefined cubes included with Advanced Reports.

This section includes the following topics:

● CallCenterQ Cube on page 91

● Contacts Cube on page 93

● CMS cube on page 95

● Contact Segment cube on page 96

CallCenterQ Cube
The CallCenterQ cube provides data for analysis by call center managers regarding 
contact, request, order or fulfillment activity, and agents on their system.

Dimensions defined in the CallCenterQ cube:

Dimension Description

Dates Date when contact, request, order or fulfillment 
record was created.

Days of the Week Based on creation time of contact, request, order or 
fulfillment records, lets you make comparisons for 
the same day across different weeks.

Time Range Based on creation time of contact, request, order or 
fulfillment records, lets you make comparisons of 
measures during the day in half hour segments.

Agents Lets you compare contacts, requests, orders or 
fulfillment orders created by agents.

Owners Lets you compare contacts, requests, orders or 
fulfillment orders owned by agents.

Workgroups Lets you compare contacts, requests, orders or 
fulfillment orders assigned to workgroups.

Contacts Lets you compare 'contacts' in CallCenterQ by 
contact types: phone, mail, fax, email, web. 
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The CallCenterQ cube contains the following measures:

Requests Lets you compare 'requests' in CallCenterQ by 
request types: Problem, Information Request, 
Compliment, Response. Drills down to 'request 
status'.

Returns Lets you compare 'returns' in CallCenterQ by return 
types: Repair, Exchange, Return, Upgrade.

Products  Lets you compare 'requests' and 'orders' by 
'Products'.

Categories  Lets you compare 'requests' by 'Categories'.

Orders  Lets you compare 'orders' in CallCenterQ by order 
status.

Measure Description

Number of Contacts  Number of 'Contacts' created in CallCenterQ.

Number of Requests  Number of 'Requests' created in CallCenterQ.

Number of Fulfillments  Number of 'Fulfillments' created in CallCenterQ.

Number of Orders  Number of 'Orders' created in CallCenterQ.

Number of Returns  Number of 'Returns' created in CallCenterQ.

Total Tasks Handled  Total number of (Requests + Fulfillments + Orders + 
Returns) created by an agent.

Fulfillment Order Total  Total dollar value of 'Fulfillment Orders'.

Order Total  Total dollar value of 'Orders'.

Quantity Ordered  Quantity of 'Products' sold (comes from 'Orders').

Total Owned Requests  Number of 'Requests' owned by an agent.

Total Owned Fulfillments  Number of 'Fulfillments' owned by an agent.

Total Owned Orders  Number of 'Orders' owned by an agent.

Total Owned Returns  Number of 'Returns' owned by an agent.

Total Tasks Owned  Total number of (Requests + Fulfillments + Orders + 
Returns) owned by an agent.

Total Assigned Requests  Number of 'Requests' assigned to a workgroup.

Dimension Description
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Contacts Cube
The Contacts cube contains the following dimensions:

Total Assigned Fulfillments  Number of 'Fulfillments' assigned to a workgroup.

Total Assigned Orders  Number of 'Orders' assigned to a workgroup.

Total Assigned Returns  Number of 'Returns' assigned to a workgroup.

Total Tasks Assigned  Total number of (Requests + Fulfillments + Orders + 
Returns) assigned to a workgroup.

Measure Description

Dimension Description

Dates Dates of the contact based on EDU creation 
time.

Days of the Week Based on EDU creation time, lets you make 
comparisons for the same day across different 
weeks.

Time Ranges Based on EDU creation time, lets you 
compare measures during the day in half 
hourly segments.

Media Types Lets you compare contact types: phone, email, 
web. Drills down to DNIS, mailbox, and 
tasktype.

#Agents/Contact Lets you compare number of Agent 
interactions for each contact.

Agents Lets you compare agent interactions between 
Agents.

Dispositions Lets you compare disposition of agent 
interactions for the following values: Normal, 
Transfer, Abandon, and Closed.

Queues Allows comparison of queues associated with 
different media types.
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The Contacts cube contains the following measures:

Tasks cube
The Tasks cube contains the following dimensions:

Measure Description

# Contacts Offered Number of EDUs created.

# Contacts Handled Number of contacts handled by an agent or 
VRU.

# Abandoned Contacts Difference between the number of contacts 
offered and the number of contacts handled.

# Agent Interactions Number of agent or VRUs handling contacts.

Avg. Contact Duration (min) Lifetime of the EDU (usually the talk time plus 
the wrapup time).

Avg. Queue Time (sec) Period of time that elapsed while the contact 
was in queue.

Avg. Answer Time (sec) Period of time that it took to answer the 
contact.

Avg. Talk Time (sec) The length of time spent talking or responding 
to the contact.

Avg. Wrap-up Time (sec) Length of wrap-up time of one agent on the 
contact.

Avg. Defer Time Length of time the message was in deferred or 
pend status

Dimension Description

All Dates Dates of the contact based on EDU creation time.

All Days of the Week Based on EDU creation time, lets you make 
comparisons for the same day across different 
weeks.

All Time Ranges Based on EDU creation time, lets you compare 
measures during the day in half hourly segments.

All Media Types Lets you compare contact types: phone, email, 
web. Drills down to DNIS, mailbox, and tasktype.
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The Tasks cube contains the following measures:

CMS cube
The CMS cube contains the following dimensions:

All Agents Lets you compare agent interactions between 
Agents

All Tasks Lets you compare Agent performance across 
different Tasks.

# of Tasks per Agent Number of Tasks handled by an Agent in a given 
Time Range.

Measure Description

# Tasks Number of tasks for agents.

Avg. Queue Time (sec) Period of time that elapsed while the contact was in 
queue.

Avg. Answer Time 
(sec)

Period of time that it took to answer the contact.

Avg. Talk Time (sec) The length of time spent talking or responding to 
the contact.

Avg. Hold Time (sec) The length of time the contact spent on hold.

Avg. Wrap-up Time 
(sec)

Length of wrap-up time of one agent on the contact.

Dimension Description

Dimension Description

Start Time The time and date (in UTC) when the call segment 
started. Call segments start when CMS receives the 
first message for the call because each call 
segment represents a call. Another segment starts 
when an agent transfers or conferences a call.

Time of Day This represents the 48 intervals, each interval is 30 
minutes.

ACD/Skill This represents all skills, organized by their 
associated ACD.
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The CMS cube contains the following measures

Note:
Note: In this cube, all dimensions are associated with all measures.

Contact Segment cube
The Contact Segment cube contains the following dimensions:

ACD/VDN This represents all VDNs, organized by their 
associated ACD.

Day of Week The day of the week.

Measure Description

Wait Time Total time the contact spent waiting in queue.

ACW Time The amount of after call work time.

Talk Time Total time the Agent spent talking with the 
customer.

Number of Abandons Total number of abandons from queue.

Number of Answers Number of calls answered by an agent.

Number of Calls Total number of calls (both answered and 
abandoned).

Percentage of 
Abandons

Percent of calls abandoned.

Average Wait Time Average wait time for all answered calls.

Average ACW Time Average ACW time for all answered calls.

Average Talk Time Average time an agent spent on talking with the 
customer.

Dimension Description

Dimension Description

All Dates Dates of the contact based on EDU creation time.

All Days of Week Based on EDU creation time, lets you make comparisons 
for the same day across different weeks.
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The Contact Segment cube contains the following measures:

Time of Day This represents the 48 intervals, each interval is 30 
minutes.

All Queues This dimension applies to non-Advocate only.

All Agents ID of the primary agent.

All Service Classes This dimension applies to Advocate only.

All Media Types Type and direction of a contact. For example "inbound 
voice" or "outbound voice."

Measure Description

Number of Contacts The number of Routing Event table records. 
(Normally, this is equal to the number of contacts).

Number of Abandons 
from Queue

Number of abandons from a queue. This measure 
applies to non-Advocate only.

Percentage of 
Abandons from Queue

Percentage of contacts abandoned. This measure 
applies to non-Advocate only.

Number of Abandons 
from Service Class

This measure applies to Advocate only.

Percentage of 
Abandons from Service 
Class

This measure applies to Advocate only.

Average Wait Time 
(sec)

Average queue time and answer time for contact 
segments.

Average Work Time 
(sec)

Average amount of time the agent spent working 
directly with the contact for all contact segments.

Average Wrap-Up Time 
(sec)

Average wrap-up time for all contact segments.

Percentage of Contacts 
Redirected

Percentage of contact segments transferred.

Average Hold Time Average hold time for all contact segments.

Number of Abandons 
from Hold/Defer

Number of abandons while an agent has the call on 
hold or the chat in deferred state.

Percentage of 
Abandons at Agent

Percentage of abandons after agent is assigned.

Dimension Description
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Note:
Note: The term "Contact" is used in this cube and related reports even though 

contact segments are actually behind the calculations. Under normal 
circumstances (that is, processes that don't loop back on themselves), the 
two calculations are equivalent.
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Report descriptions
This section organizes reports first by logical data: Contacts and tasks, CallCenterQ, HRQ, 
Email Management, CMS and Contact segment, and then by Advanced Reports report 
type: PowerPlay or Impromptu. The list gives the report�s file name and full description. 

This section includes the following topics:

● Contacts and tasks on page 99

● CallCenterQ on page 100

● Email Management on page 103

● HRQ on page 105

● CustomerQ on page 106

● CMS on page 107

● Contact Segment on page 108

Contacts and tasks

Predefined PowerPlay reports for Contacts Cube

File Name Description

abandon.ppr Abandoned calls by Time of Day.

abandon2.ppr Contacts abandoned while ringing or on hold.

agentmedia.ppr Agent Interactions by Agent Group and Media type.

autoagent.ppr Contacts handled by Automatic Agent.

interactions.ppr Agent interactions by Time of Day for Agent Groups and Phone 
media type.

media.ppr Contacts Offered by Time of Day for all media types.

profile.ppr Number of Contacts offered by Time of Day and Day of Week.

queuetime.ppr Average Queue Time per interaction for contacts.
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Predefined PowerPlay reports for Tasks Cube

Predefined Impromptu reports for Contacts Cube

CallCenterQ

Predefined Impromptu reports

File Name Description

agentgroup.ppr Number of tasks handled by Agent Group for all media types.

agenttalk.ppr Average talk time for each Agent for single task contacts by Media 
type.

tasktime.ppr Average Talk Time for each task type by media type.

File Name Description

Drill_agent.imr Contacts by date, type and agent with average times (queue time, 
talk time, answer time & wrap up time).

Drill_contact.imr Contacts by date and type with average duration.

File Name Description

Contacts By Agent.imr Contacts By Agent � lists all contacts by agent for a user 
specified time range.

Anonymous Count Graph.imr Anonymous Call Count by Category (Graph) � displays bar 
graph showing total anonymous calls per category for a 
user specified time range.

Anonymous Count.imr Anonymous Call Count by Category � lists all anonymous 
calls by category for a user specified time range.

Lit Stock Levels.imr Stock Status of Literature Stock Items � lists availability and 
stock status of all fulfillment items whose status is �current�.

Orders by Agent and 
Customer.imr

Orders By Agent and Customer � lists Orders by Agent and 
Customer, created during a user specified time range and 
include ID, total order amount and their current status.

Vouchers.imr Vouchers By Agent � lists fulfillment orders by Agent and 
customer.
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Predefined PowerPlay reports

Agent Requests by 
Category.imr

Requests by Agent and Category � lists Requests by Agent 
and Category, created during a user specified time range 
and includes request create date and summary.

Closed Requests.imr Closed Requests by Priority � lists Requests with status 
�Closed� by �Request Priority�. Lists all requests created 
during a specified time range and includes request 
summary, create date, closed date and 'days to close' 
information.

Open Requests by 
Category.imr

Open Requests by Category � lists all �Open� Requests, 
sorted by Category, created during a specified time range 
and includes request summary and duration that the 
request has been open.

Request Count by Category 
and Status.imr

Request Count by Category and Request Status � lists 
Request count sorted by Category and Request Status for a 
specified time range.

Requests by Category 
Graph.imr

Total Requests per Category � displays bar graph showing 
total Request per Category for a specified time range.

Requests by Category.imr Requests by Category � lists count of Requests sorted by 
Category created during a specified time range.

Requests by Customer and 
Category.imr

Requests by Customer and Category � lists Requests by 
Customer and Category, created during a specified time 
range. The report includes Agent and Request �Priority� 
details.

Requests by Product 
Graph.imr

Requests by Product Graph � displays bar graph showing 
total Requests per Product created during a specified time 
range.

Requests by Product.imr Requests by Product � lists Requests by Product, created 
during a specified time range. The report includes request 
summary, priority and status information.

File Name Description

File Name Description

ContactsByTimeOfDay.ppr Contact count by contact method and time of day.

FulfillmentAmountByAgent.ppr Fulfillment amounts by Agent and day of week.

OrdersByDayOfWeek.ppr Number of Orders and Order Amounts by day of week.

ProductQntyOrdered.ppr Quantities of Products sold.
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Predefined Impromptu reports for CallCenterQ Cube

RequestsByCategory.ppr Requests by Category and day of week.

RequestsByProduct.ppr Requests by Product and day of week.

RequestTypebyStatus.ppr Requests created by day of week, organized by �Type� and 
�Status�.

ReturnsByDayofWeek.ppr Returns by �Type� and day of week.

TasksAssignedToWorkgroups.ppr Total number of �Requests�, �Fulfillments�, �Orders� and 
�Returns� that are currently assigned to workgroups.

TasksHandledByAgent.ppr Total number of �Requests�, �Fulfillments�, �Orders� and 
�Returns� that have been created in the system by �Agent�.

TasksOwnedByAgent.ppr Total number of �Requests�, �Fulfillments�, �Orders� and 
�Returns� that are currently owned by �Agent�.

File Name Description

File Name Description

drill_fulfillment.imr Drill-through Ad-hoc report for 'ccq' cube, showing a list of all 
�Fulfillments� by �Agent� and �Customer�. This drill-through report is 
available for measure �Total Fulfillments�. Further, the �Fulfillment ID� 
field in this Ad-hoc report has a drill-through link to another report � 
drill_fulfillmentdetail.imr that shows details of fulfillment order for that 
Fulfillment ID.

drill_fulfillmentdetail.imr Shows details of Fulfillment Order with a prompt for the user to 
specify �Fulfillment Order Number�.

drill_order.imr Drill-through Ad-hoc report for ccq cube, showing a list of all �Orders� 
by �Agent� and �Customer�. This drill-through report is available for 
measure �Total Orders�. Further, the �Order ID� field in this Ad-hoc 
report has a drill-through link to another report � drill_orderdetail.imr 
that shows details of that specific Order. 

drill_orderdetail.imr Shows details of an �Order� with a prompt for the user to specify 
�Order Number�.

drill_orderowner.imr Drill-through Ad-hoc report for 'ccq' cube, showing a list of all 
�Orders� by �Owner�. This drill-through report is available for 
measure �Total Orders�. Further, the �Order ID� field in this Ad-hoc 
report has a drill-through link to the report � drill_orderdetail.imr that 
shows details of that specific Order.

drill_request.imr Drill-through Ad-hoc report for ccq cube, showing a list of all 
�Requests� by �Agent� and �Customer�. This drill-through report is 
available for measure �Total Requests�.
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Email Management

Predefined Impromptu reports

drill_requestbycategory.imr Drill-through Ad-hoc report for ccq cube, showing a list of all 
�Requests� by �Request Category�. This drill-through report is 
available for measure �Total Requests�.

drill_requestbyproduct.imr Drill-through Ad-hoc report for ccq cube, showing a list of all 
�Requests� by �Product�. This drill-through report is available for 
measure �Total Requests�.

drill_return.imr Drill-through Ad-hoc report for ccq cube, showing a list of all 
�Returns� by �Agent�. This drill-through report is available for 
measure �Total Returns�. Further, the �Return ID� field in this Ad-hoc 
report has a drill-through link to the report � drill_returndetail.imr that 
shows details of that specific Return.

drill_returndetail.imr Shows details of a �Return� with a prompt for the user to specify 
�Return Number�.

File Name Description

File Name Description

AgentResponseTimeRange.imr Detailed Agent Response Time Range Report � lists 
message responses by selected agents, with columns 
for Response Time, in a format that lists all agents 
together, allowing direct comparison between agents.

CompleteAgentResponse.imr Detailed Agent Response by Date Range Report � lists 
message responses by selected agents, with columns 
for Tracking Number, Date Taken, Date Responded, 
Response Time, Pool, From and Subject.

CustomerTrackingReport.imr Detailed Customer Email Management Tracking Report 
� lists messages for selected customer email 
addresses, with columns for Tracking Number, Date 
Received, Date Responded, Pool, Agent Assigned and 
Subject.

QueueResponseTimerange.imr Detailed Pool Response Time Range Report � lists the 
response times in intervals from Zero � Two Hours to 
Over 48 hours for each pool, with the number of 
messages responded for each reporting interval.
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Predefined PowerPlay reports

File Name Description

AgentResponseTime.ppr Detailed Agent Response Time Range Report � lists 
message responses by selected agents, with 
columns for Response Time, in a format that lists all 
agents together, allowing direct comparison between 
agents.

AgentInteractionsByQueues.ppr Detailed Agent by Pool Report � lists messages 
selected for each message pool, with columns for 
Messages Taken, Messages Responded, Messages 
Forwarded, Messages Outstanding, Messages 
Resolved and Average Response Time.

AgentInteractionsByContactEntrypoint.ppr Detailed Agent Interactions by Contact Entry Point 
Report � lists number of contacts offered, number of 
contacts handled, number of abandoned contacts 
and number of agent interactions, as well as average 
contact duration, average queue time, average 
answer time, average talk time, average defertime, 
and average wrap -up, defertime. 

ContactEntrypointTrafficTrends.ppr Detailed Contact Entry Point Traffic Trends Report � 
lists number of contacts offered, number of contacts 
handled, number of abandoned contacts and number 
of agent interactions, as well as average contact 
duration, average queue time, average answer time, 
average talk time, average defer time and average 
wrapup time, defertime. 

QueueTrafficTrends.ppr Pool Monthly Traffic Trends Report � lists month by 
month activity of selected pools, with columns for 
Pool and Month.

QueueTrafficByHour.ppr Pool Traffic By Hour Report � creates a graphical 
report showing percentage of the selected pools 
message traffic by hour.

ResponseTimesByContactEntrypoint.ppr Mail Account Summary Report � lists Contacts 
Summary showing different average times such as 
queue time and response time.
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HRQ

Predefined Impromptu reports

File Name Description

average_tasks_percategory.imr Average Tasks per Category - a report of issues created 
during a period of time defined by input parameters. 
Grouped by category name, includes the number of 
issues, number of tasks and average number of tasks 
for the category. 

category_issue.imr Issues per Category - for a period of time defined by 
input parameters, a summary of issues within a 
category. Totals are reported for each status (new, 
closed, assigned) and an overall issue total for the time 
period.

category_issue_graph.imr Issues per Category Graph - for a period of time defined 
by input parameters, a bar graph of the total number of 
issues reported by category. 

inside_outside_callers.imr Inside Outside Callers - for a period of time defined by 
input parameters, a chart which shows what percent of 
calls are made by a caller who is the same as the 
participant compared to the percent of calls made by a 
caller who is not the participant.

issue_resolution_time.imr Average Resolution Time per Category - for a period of 
time defined by input parameters, a report, grouped by 
category, listing specific issues for the time period and 
details about the time to resolve each issue. An average 
time to resolve all issues for each category is provided. 

litstock_level.imr Litstock Level Within 10% of Re-order - an analysis of 
the quantities of stock on hand and committed. Stock 
will appear on this report if the quantity on hand minus 
the quantity committed is equal to or greater than the 
reorder level plus 10%.
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CustomerQ

Predefined Impromptu reports

File Name Description

call_act.imr Call Activity Summary Report - a daily summary, with the date provided 
as an input parameter, grouped by workgroup, of the amount of time 
spent to resolve calls. Time spent is classified by �workgroup support�, 
�owner support�, and �all support�. Another type of classification is 
provided by �phone time,� and �research time.� It also includes �must 
resolve by� date and indicator of whether the call was closed in time.

call_sum.imr Call Summary for the Period - a summary over a period of time, 
parameters input by the user, grouped by workgroup, of the quantity of 
calls in various states during the period. States counted are �opened,� 
�closed,� �pending,� and �outstanding.� Totals are included for time spent 
on the phone, in research, and total support. Also summarized are the 
average days/hours to close and the number of calls closed in time.

ccal_sta.imr Closed Call Performance Statistics - a report by region, and organization 
of the overall time spent and efficiency, grouped by workgroup, within a 
time window specified by input parameters. Measures include �number of 
calls,� �number of calls closed in time,� �average time to close.� Time is 
further classified by phone, research, and support time. Efficiency 
measures are �average times (call) touched,� and �average owners per 
call.� A summary is provided for the organization as well.

cust_inf.imr Customer Information Sheet - a summary for a given customer. Includes 
contact information for the customer and organization data. A summary of 
the service contract and past calls is provided.

def_sum.imr Defect Performance Summary - a list of defects for a given time period 
(parameters input by user) along with a summary for the period. Several 
attributes of the defects are reported including priority, state, severity, and 
business impact. Employees involved are listed as well as measures 
around time to fix and dates reported and fixed. The summary for the 
period includes number of defects reported, open, and closed as well as 
number resolved within estimates and on schedule.

soln_sum.imr Solution Summary - a listing of all of the problems and their 
corresponding solutions. Includes other attributes such as �status,� �date 
created,� and when �last used.�
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CMS

Predefined PowerPlay reports

Use the following reports to determine your busy times:

Use the following reports to determine your queue abandon rates:

Use the following reports to determine which skills require more agent coverage:

File Name Report Title

callsByTimeOfDaySkill.ppr Number of Calls by Time of Day (by ACD/Skill)

callsByTimeOfDayVDN.ppr Number of Calls by Time of Day (by ACD/VDN)

pctCallsByTimeOfDaySkillAllAcd.ppr Percentage of Calls by Time of Day for All ACDs (by 
ACD/Skill)

pctCallsByTimeOfDaySkillForAcd.ppr Percentage of Calls by Time of Day for All ACDs (by 
ACD/VDN)

pctCallsByTimeOfDayVDNAllAcd.ppr Percentage of Calls by Time of Day for an ACD (by 
ACD/Skill)

pctCallsByTimeOfDayVDNForAcd.ppr Percentage of Calls by Time of Day for an ACD (by 
ACD/VDN)

File Name Report Title

abandonsByTimeOfDaySkill.ppr Number of Abandons by Time of Day (by ACD/Skill)

abandonsByTImeOfDayVDN.ppr Number of Abandons by Time of Day (by ACD/VDN)

pctAbandonsByTimeOfDaySkill.ppr Percentage of Abandons by Time of Day (by ACD/Skill)

pctAbandonsByTImeOfDayVDN.ppr Percentage of Abandons by Time of Day (by ACD/VDN).

File Name Report Title

abandonsBySkill.ppr Number of Abandons by ACD/Skill

avgWaitTimeBySkill.ppr Average Wait Time by ACD/Skill
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Use the following reports to determine which skills have the longest work time:

Contact Segment
The tables in this section define the Advanced Reports for Contact Segment data.

Note:
Note: All reports named ContactBy(*)AndSite reflect inbound non-Advocate 

data only.

Predefined Improptu reports

Use the following reports to determine your busy times:

Note:
Note: These Impromptu reports are not available if you are using Chinese, 

Japanese or Korean language reports.

File Name Report Title

avgTalkTimeBySkill.ppr Average Talk Time by ACD/Skill

avgACWTimeBySkill.ppr Average ACW Time by ACD/Skill

File Name Description

ContactsByTimeOfDayAndSite.imr Number of Contacts by Time of Day (by Site)

ContactsByDayOfWeekAndSite.imr Number of Contacts by Day of Week (by Site)

ContactsByDayOfYearAndSite.imr Number of Contacts by Day of Year (by Site)

ContactsByWeekOfYearAndSite.imr Number of Contacts by Week of Year (by Site)

ContactsByMonthAndSite.imr Number of Contacts by Month (by Site)

ContactsByMonthOfYearAndSite.imr Number of Contacts by Month of Year (by Site)

ContactsByQuarterAndSite.imr Number of Contacts by Quarter (by Site)

ContactsByYearAndSite.imr Number of Contacts by Year (by Site)

ContactsByTimeOfDayAndMedia.imr Number of Contacts by Time of Day (by Media Type)

ContactsByDayOfWeekAndMedia.imr Number of Contacts by Day of Week (by Media Type)

ContactsByDayOfYearAndMedia.imr Number of Contacts by Day of Year (by Media Type)
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Use the following report to determine what kind of work is handled at each site:

Predefined PowerPlay reports

Use the following reports to determine your busy times:

Use the following reports to determine your queue abandon rates:

ContactsByWeekOfYearAndMedia.imr Number of Contacts by Week of Year (by Media Type)

ContactsByMonthAndMedia.imr Number of Contacts by Month (by Media Type)

ContactsByMonthOfYearAndMedia.imr Number of Contacts by Month of Year (by Media Type)

ContactsByQuarterAndMedia.imr Number of Contacts by Quarter (by Media Type)

ContactsByYearAndMedia.imr Number of Contacts by Year (by Media)

File Name Description

File Name Report Title

ContactsBySiteAndMedia.imr Number of Contacts by Site and Media Type

File Name Report Title

ContactsByTimeOfDayQueue.ppr Number of Contacts by Time of Day (by Queue)

ContactsByTimeOfDayServices.ppr Number of Contacts by Time of Day (by Service Class)

ContactsByTimeOfDayMediaTypes.ppr Number of Contacts by Time of Day (by Media Types)

PctContactsByTimeOfDayQueue.ppr Percentage of Contacts by Time of Day (by Queue)

PctContactsByTimeOfDayServices.ppr Percentage of Contacts by Time of Day for a Service 
Class

PctContactsByTimeOfDayAllServices.ppr Percentage of Contacts by Time of Day for All Service 
Classes

PctContactsByTimeOfDayMediaTypes.ppr Percentage of Contacts by Time of Day (by Media 
Type)

File Name Report Title

AbandonsByTimeOfDayQueue.ppr Number of Abandons by Time of Day (by Queue)

AbandonsByTimeOfDayServices.ppr Number of Abandons by Time of Day (by Service 
Class)
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Use the following reports to determine which types of work have the longest work time:

PctAbandonsByTimeOfDayMediaTypes.ppr Percentage of Abandons by Time of Day (by Media 
Types)

PctAbandonsByTimeOfDayQueue.ppr Percentage of Abandons by Time of Day (by Queue)

PctAbandonsByTimeOfDayServices.ppr Percentage of Abandons by Time of Day (by Service 
Class)

File Name Report Title

File Name Report Title

AvgWorkTimeByQueue.ppr Average Work Time by Queue

AvgWorkTimeByServices.ppr Average Work Time by Service Class

AvgWrap-UpTimeByQueue.ppr Average Wrap-Up Time by Queue

AvgWrap-UpTimeByServices.ppr Average Wrap-Up Time by Service Class
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Multidimensional cubes
OA R6.1 Advanced Reports enable you to explore the data collected by Interaction Center 
or CMS in a multi-dimensional cube. You can view and compare calls per hour by agent, 
abandoned calls by type per day, and so on. 

Each multidimensional cube contains a summary of cumulative information about call 
center activities and transactions performed by agents over specified periods of time. This 
information provides call center managers with a look at trends in the call center, such as 
the most frequently used media for contacts, or the number of contacts handled by agents 
in a specific time period.

Depending on your organization�s needs, you can view the information in the cube in 
different combinations of measures and dimensions, and in various formats, such as a 
table, line graph, bar graph, pie chart, or multi-dimensional graph.

This section includes the following topics:

● Selecting Measures and Dimensions on page 111

● Selecting the Graphical Display Format on page 112

● Drilling Through the Cube on page 113

● Saving multidimensional cube views on page 115

● Modifying Multidimensional Cubes on page 115

Selecting Measures and Dimensions
The dimensions and measures determine the information you see in a particular view of 
the cube. If one view does not work, you can select different measures or dimensions that 
better suit your information needs.

You change the dimensions and measures you see in a view of the cube from the 
Dimension Viewer or the Dimension Line. Multidimensional cubes retain all other measure 
and dimension settings.

The Dimension Viewer is an organized view of all dimensions, levels and categories in the 
cube. You may add categories, format measures, filter and defines sets of categories using 
the viewer.

Each folder on the Dimension line below the toolbar, except the last, corresponds to a 
dimension in the cube. Click on the folder to display the data elements within the 
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dimension. The box on the far right of the Dimension line is the currently selected 
measure. Select another measure by clicking on this box.

Measures determine the type of information included in the cube. There are two types of 
measures. Direct fields pull data directly from columns in a database table. Calculated 
fields use a hotfile and data from database tables to calculate the information included in 
the cube. For example, all time measures are calculated fields that use the time ranges in 
the timeranges hotfile for the calculations. 

Not all measures apply to all dimensions. For example, the # Contacts Handled measure 
doesn't apply to the Agents dimension because a contact can be handled by multiple 
agents. Instead, the # Agent Interactions measure applies to the Agents dimension. 

Selecting the Graphical Display Format
You can choose different methods of displaying the cube data, depending on how the 
information will be used. You may need to try different graphical display formats until you 
find the most effective for each type of information. For example, you can use a multi-line 
graph to show trends, and a multi-dimensional graph to compare two or more dimensions 
or measures across two time periods. 

You can change the format from the Display option of the Insert menu, or by clicking on 
any of the ten report display buttons on the upper right of the toolbar.
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The following Multidimensional cube formats are used in the provided predefined 
Multidimensional Reports:

Drilling Through the Cube
If you would like more details about information in the cube, you can drill through the cube 
to a detail report and view information not available in the cube. When you choose the Drill 
Through option, Impromptu opens, queries the database, then displays the information in a 
table with summary lines at the bottom.

Advanced Reports� Contacts cube provide two report templates with the format of the Drill 
Through tables: 

● drill_agent

● drill_contact

Note:
Note: The Drill Through option is only available for views of the Contacts cube that 

are defined by the following four measures: # Contacts Offered, # Contacts 
Handled, # Abandoned Contacts, and # Agent Interactions.

You determine the Drill Through filters by selecting sections of a cube view in a 
multidimensional cube. The more records in the section you select, the longer the drill 
through and formatting of the detail tables takes. You can see the number of records in the 
selected section at the bottom left of the multidimensional cube window.

The the following example shows the report generated after drilling through the Contacts 
cube to the database for more information about agent contacts across all media in a 
chosen time range on a specific date.

To drill through the cube to the database:

1. In a multidimensional cube, open the Contacts cube.

2. Select a view that is defined by one of the first four measures.

Format Report Title Report File Name

Crosstab Agent Talk agenttalk.ppr

3D bar graph Profile profile.ppr

Simple bar graph Abandons abandon2.ppr

MultiLine graph Media media.ppr
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3. Select the section of the view for which you want more information.

4. Double-click a bar in the view.
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5. Log in to the database for Impromptu.

Impromptu opens and displays the requested database information in a table.

Saving multidimensional cube views
You can save any particular view of a cube as a PowerPlay (PPR) file. Opening the 
PowerPlay file opens the cube showing that view. You do not need to update the PPR file 
when you update the cube. 

Modifying Multidimensional Cubes
This section provides an example of why you might want to modify a multidimensional 
cube and how to carry out the modification.

The cubes provided by Advanced Reports do not contain a Customer dimension. The only 
reference to customers in repository is the key to the Customer table. However, this key is 
included in the query files used to build the cube.

Before adding a Customer dimension, you need to create customer groups, so that the 
dimension provides meaningful contact data. A dimension that just contains the key to the 
customer table will likely have too many categories to provide useful information. 
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This example uses a feature of the CallCenterQ data model. CallCenterQ has a link from 
the Customer table to �condemogroup�, an alias of the demographicgroup table. This is a 
generic table for organizing customers into groups. Using this link, you can add a 
Customer dimension to the Contacts cube that lets you view the contact data in the cube 
by demographic group. 

Assuming that you have defined different logical databases for Repository, CustomerQ, 
HrQ, CallCenterQ and Contact Segment, you will be prompted to log in to each database 
when you re-build the Contacts cube. Although you are not creating a join across tables 
between the databases, Customer Key is treated as the same thing when applying 
measures, having the effect of a join.

Tip:
Tip: For more information about modifying Multidimensional Cubes, refer to 

documentation provided with the PowerPlay application.

How to make the modification

To add a dimension to the Contacts cube that shows demographic customer groups: 

1. Verify that the catalog file that you plan to use exists and is setup to connect to the 
desired database. 

2. Create an Ad-hoc Report (IMR) file via Cognos Impromptu, with the following fields: 

● customer.pkey 

● customer.fullname 

● condemogroup.name 

Note:
Note: You can omit the second field if you do not want to store customer names in 

the cube.

3. Change the column names for the fields:

● customer.pkey to �Customer Key�

● condemogroup.name to something your organization can easily identify, such as 
�Demographic Name�

4. Save the IMR file as an Ad-hoc Query Definition (IQD) file. 

5. Open the contact.mdl Model File in Transformer.

6. Add the new IQD file to the set of Data Sources: 

a. Right-click in the Data Sources window and select Insert Data Source.

b. In New Data Source field, enter Customer in the Data Source Name field and IQD 
in the Source Type field, then select Next.
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c. Browse for the IQD file, and select Finish.

d. Login to the database.

7. Add a new All Customers dimension: 

a. Right-click in the Dimension Map window and select Insert Item.

b. In the Dimension dialog box, enter All Customers in the Dimension Name field, 
select Regular for Dimension Type, then select OK.

8. Add Demographic Name as a top level category: 

a. Right-click in the All Customers column and select Insert Level.
b. Select �...� under Source.

c. Select More.

d. Select Demographic Name from the Source column list.

9. Add Customer Key as a second level category: 

a. Right-click in the All Customers column and select Insert Level.
b. Select �...� under Source.

c. Select More.

d. Select Customer Key under the Source Column field.

e. Select Fullname from the Label Column field.
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f. Check Unique in the check boxes on the right side of the dialog box.

10. To suppress the ability to drill down to individual customer names:

a. Select Diagram > Show Diagram from the menu bar.

b. Select All Customers.

c. Right-click on Customer Key, then select Suppress.

11. Save the model file.

12. Create the cube file.
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Appendix A: Optional support tasks for 
Advanced Reports

This appendix describes optional tasks you can perform to customize Advanced reports for 
your particular installation.

This section includes the following topics:

● Creating multidimensional cubes on page 120

● Updating multidimensional cubes on page 123

● Database connectivity tasks on page 126

● Customizing the data model on page 135
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Creating multidimensional cubes
Multidimensional cubes contain selected data from your Customer Interaction Repository 
database. You can customize multidimensional cubes to provide exactly the statical data 
you desire.

This section includes the following topics:

● Required files on page 120

● Create a multidimensional cube on page 121

● Create the cube file on page 121

Required files
You create multidimensional cubes with the following files:

● MDL file� Multidimensional cube model file that defines the dimensions of the cube, the 
measures for the dimensions, and the queries that define how the cube is populated.

● IQD files� Impromptu Query Definition files, one created from each IMR file, that define 
a set of queries. These queries contain the connection information and SQL query 
which is executed in the database when the cube is built.

● Iims file� Hotfile that specifies time ranges for viewing data in cubes.
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● Database� Database connections set in Impromptu Administrator that specify which 
database populates the cube.

.

Create a multidimensional cube
To create a multidimensional cube:

1. Define your logical database in Impromptu Administrator.

2. Make sure that the Cognos Catalog that you plan to use for providing data to the 
Transformer exists in the correct location.

3. Make sure that the Impromptu files and their corresponding IQD files are in place. 
They will be used as data sources by the Transformer.

4. Build the cube in PowerPlay Transformer.

Create the cube file
To create the cube file:

1. In PowerPlay Transformer, open the model file for the cube. 
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2. Define the target cube�s destination (or else you might inadvertently delete an existing 
cube). Select File > Preferences and then select Directories to setup the default 
directories for the cube. 

3. Select Run > Create PowerCubes.

4. In the Database Access dialog box, enter your database login and password and 
select OK. 

Transformer executes the IQD queries against the database and stores the results in 
the MDC cube file.
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Updating multidimensional cubes
You may choose to incrementally update a multidimensional cube rather than creating a 
new cube each time you want to report on a different set of data. To incrementally update a 
cube:

● Modify the source files with an appropriate filter.

● Modify the model file to show This cube is incrementally updated.

Before incrementally updating a cube you should consider the following points:

● Remember that dates are saved in the database in GMT. Be careful that your 
incremental update strategy does not result in data overlaps because it may result in 
incorrect data in the cube.

● Cognos recommends that you periodically recreate the cube to take advantage of its 
auto-partitioning scheme.

● Whenever you make structural changes to your data model, you must recreate the cube 
before attempting incremental updates.

Note:
Note: Refer to the Cognos documentation for more details about incremental cube 

updates.

Incremental cube update example
This example shows a simple approach to incrementally updating a cube. The example 
assumptions are:

● The update strategy is to perform an incremental update of the MMA cube daily at 1:00 
AM, Denver time. 

● The database server is located in the Denver timezone (GMT -07:00 during daylight 
savings time).

The following procedure is used to create the incremental update:

1. Save the original .imr, .iqd, and .mdl files:

● Copy .../cubes/MMA/routing.imr to 
.../cubes/MMA/routing_create.imr.

● Copy .../cubes/MMA/routing.iqd to 
.../cubes/MMA/routing_create.iqd.

● Copy .../cubes/MMA/contactsegment.mdl to 
.../cubes/MMA/contactsegment_create.mdl.
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2. Create the first cube at 1:00 AM Denver time.

3. Open .../cubes/MMA/routing.imr and add this filter condition:

createtime > (now()+000 06:00:00.000) and createtime 
<=(now()-000 18:00:00.000)

This filter assures that the cube is updated with the last 24 hours of data. The filter 
must be changed when daylight saving time ends to account for the difference from 
GMT.

Note:
Note: createtime is defined in the Contact folder.

4. Save the modified file as .../cubes/MMA/routing.imr and 
.../cubes/MMA/routing.iqd.

5. Modify the cube property to This cube is incrementally updated in the 
.../cubes/MMA/contactsegment.mdl file.

Note:
Note: Ignore the warning message (TR0719) that appears when you modify the 

cube property.

6. Schedule the cube update to occur every day at 1:00 AM Denver time.

The following table shows the column name for the time dimension for each cube.

Cube time dimension Column name

For CallCenterQ

contacts.imr contact.datecreated

fulfillment.imr litorder.dateentered

order.imr orderentry.dateentered

request.imr request.datecreated

return.imr returns.dateentered

For CMS

cms.imr cmscallhistory.segstart

For Contacts

contact.imr contact.createtime

routing.imr contact.createtime

For MMA

routing.imr contact.createtime
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For tasks

task.imr contact.createtime

Cube time dimension Column name
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Database connectivity tasks
This section discusses connectivity tasks. You may need to perform specific procedures to 
make sure your Advanced reports and cubes function properly. 

Note:
Note: For more detailed procedures and information about the special 

considerations in this section, refer to documentation provided with the 
Cognos applications.

This section includes the following topics:

● Changing the logical database name on page 126

● Generating Cognos catalogs on page 126

● Adding the TimeRanges hotfile to repository catalog on page 129

● Adding the TimeRanges hotfile to ccq catalog on page 133

● Confirming catalog contents on page 133

Changing the logical database name
If you want to use an Advanced reports logical database name other than repository, 
ccq, customerq or hrq, you must:

1. Regenerate the catalog (see Generating Cognos catalogs on page 126).

2. Regenerate the IQD files by opening the Predefined, Detailed, Drill-Through Reports 
under the cognos\cubes\ directory (using Impromptu Administrator) and then 
saving them as file type IQD. 

3. Open Transformer and, in the Signon window, select and delete the repository, 
ccq, customerq or hrq signon, respectively.

The new logical database signon is added automatically when you build the cube.

Generating Cognos catalogs
In OA R6.1, if a new Catalog for repository, ccq, hrq, or custq is generated using 
Database Designer, the pre-existing reports that use the catalog will not work - either the 
data shown on the report will be incorrect or you will see this error message: This report 
will result in a 'cross product' query. This User Profile prevents the use of 'cross 
product' reports. Therefore, it is advised that unless necessary, do not recreate the 
catalog files using Database Designer. 
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Note:
Note: The oadb catalog file cannot be generated from Database Designer.

If you simply need to add a few more tables and joins to the catalog, you can update it 
using Impromptu Administrator. If it is absolutely necessary to generate a new catalog 
using Database Designer, you can do so using the following procedure. You must rerun the 
data queries in the existing reports in order to make them work with the newly generated 
catalog. You should be able to create new reports without any problems using the new 
catalog.

! Important:! Important:
Important: You should update the Cognos catalog after you modify the data model.

To generate a Cognos Catalog for Customer Interaction Repository:

1. Verify that you have defined a logical connection for CallCenterQ database in 
Impromptu Administrator to your database. Name the Logical Database Name ccq.

2. Verify that you have defined a logical connection for repository database in 
Impromptu Administrator to your database. Name the Logical Database Name 
repository.

3. In Database Designer, open the repository.adl file. 

4. Select Tools > Export for Cognos Catalog.

5. In the Cognos Catalog Generation dialog box, select qrepositoryDataSource from 
the Data Source field, then select Next. 
The Database Name and Database Type fields are automatically filled.

6. Enter the Catalog name repository.cat and the Cognos logical database name in 
the appropriate fields, then select Generate Catalog.

Typically, the Database Name and Database Type fields are for your information only, 
and you cannot change the information in these fields. However, if you select a data 
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source that refers to a database type that Advanced reports does not support, such as 
ODBC, you must change the Database Type field.

Note:
Note: The primary connection/secondary connection does not automatically do a 

join between primary and secondary connection. 

To add the table customer to the repository catalog:

1. Select Catalog > Tables menu item in Impromptu Administrator.

2. Select ccq database under Database Tables.

3. Double-click on the database name to see all tables in the database. 

4. Select customer table and select Add to add this table to the catalog.

5. Name this catalog folder Customer.

6. You must define the join between contact and customer.

See Adding the TimeRanges hotfile to repository catalog on page 129 for instructions 
on adding a join in Impromptu Administrator.

Note:
Note: If you get an error during the catalog generation, such as Database value is 

not defined or Error in Catalog Generation, the Cognos catalog is not 
properly generated even if it appears in the directory. Verify that you have 
created the database definition in Impromptu Administrator, then regenerate 
the catalog.

Table A Table A Join 
Key

Table B Table B Join Key

contact customer_key customer pkey
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Adding the TimeRanges hotfile to repository catalog
An Advanced reports hotfile is a file serving as a table to define certain fixed data. The 
TimeRanges hotfile defines appropriate time ranges for reporting within the 
Multidimensional cubes. You must add the TimeRanges hotfile to the repository 
catalog by:

1. In Impromptu Administrator, open the repository.cat catalog.

2. Add the folder TimeRanges to the catalog.

3. From the Catalog menu, select Tables.

4. Select HotFiles.

5. Select the just created TimeRanges folder and select OK. The folder�s path appears 
above the Database Tables field.

6. In the Database Tables field, browse for the TimeRanges.ims hotfile to add to your 
catalog, and then select Add.

7. Select OK.

8. For drill through to Predefined, Detailed, Drill-Through Reports to work, you must add a 
join between the contact table and the timeranges table as follows:

a. Select Catalog > Joins to open the Joins dialog box.

b. Select the contact table in the Join Paths field.

c. Select the timeranges table in the Available Tables field.

d. Select Add.
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e. Create the join from the options in the Join Components field as shown in the 
example below, that is, hour(contact.�createdate�) * 60 + minute 
(contact.�createdate�) = timeranges.ims.�Time�

.

f. Select OK to save the join.

Generating a Cognos Catalog for CallCenterQ

1. Verify that you have defined a logical connection for CallCenterQ database in 
Impromptu Administrator to your database. Name the Logical Database Name ccq.

2. Verify that you have defined a logical connection for repository database in 
Impromptu Administrator to your database. Name the Logical Database Name 
repository.

3. In Database Designer, open the ccq.adl file (ADL file for CallCenterQ). 

4. Select Tools > Export for Cognos Catalog.

5. In the Cognos Catalog Generation dialog box, select ccqDataSource from the Data 
Source field, then select Next. 
The Database Name and Database Type fields are automatically filled. 

6. Select �...� and browse to a selected location for the new Cognos catalog. A good 
location is the reports folder for CallCenterQ: 
Program Files\avaya\BI\Rreports\Cognos\Impromptu\CallCenterQ
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7. Enter the Catalog name ccq.cat and the Cognos logical database name in the 
appropriate fields, then select Generate Catalog.

Typically, the Database Name and Database Type fields are for your information only, and 
you cannot change the information in these fields. However, if you select a data source 
that refers to a database type that Cognos does not support, such as ODBC, you must 
change the Database Type field.

In IC R6.1, employee and workgroup tables, which formerly resided in ccq database, have 
moved to repository database. However, the old employee and workgroup tables have 
not been dropped. In the ccq.adl file, they are named respectively, employee_old and 
workgroup_old. At the ccq database level they remain employee and workgroup.

When you generate ccq.cat, the Cognos catalog for the CallCenterQ, the catalog 
references the �old� employee and workgroup tables in ccq database. You must:

● rename the catalog folders for Employee and Workgroup

● modify the catalog to reference these tables as they appear in the repository 
database

To rename the catalog folders for Employee and Workgroup:

1. In Impromptu Administrator, open the ccq.cat catalog.

2. Select Catalog > Folders menu item in Impromptu Administrator.

3. Highlight Employee in the Catalog Folders field. 

4. Select Edit... and rename Employee to EmployeeOld.

5. Highlight Workgroup in the Catalog Folders field.

6. Select Edit... and rename Workgroup to WorkgroupOld.

7. Close the Folders dialog.

To add the tables Employee and Workgroup from repository to the ccq catalog:

1. In Impromptu Administrator, open the ccq.cat catalog.

2. Select Catalog > Tables menu item in Impromptu Administrator.

3. Select repository database under Database Tables.

4. Double-click on the database name to see all tables in the database. 

5. Select Employee table and select Add to add this table to the catalog.

6. Select Workgroup table and select Add to add this table to the catalog.
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You must define the following inner joins between tables. To define a join refer to the steps 
from Adding the TimeRanges hotfile to ccq catalog on page 133.

You must also define the following additional aliases for the table employee, and joins to 
those aliases. To define these table aliases: 

1. Select Catalog > Tables.

2. Select repository database under Database Tables.

3. Double-click on the database name to see all tables in the database. 

4. Select Employee table and select Alias to designate the alias name.

5. Enter an alias name from the list below. Select OK.

6. Select OK in the Tables dialog.

7. Joins dialog is displayed. Enter the appropriate join keys from the table. Select OK.

8. Repeat from step 4, and enter all joins from table.

Table A Table A Join 
Key

Table B Table B Join Key

w_task_detail agent_id employee pkey

w_agent_summary agent_id employee pkey

w_agent_summary team_id workgroup pkey

w_task_detail customer_id customer pkey

Catalog Folder 
Name or Table 
Alias

Table Join Key Employee Table 
Alias

Alias Join 
Key

contact contactagent_key  Contactagent  pkey 

orderentry agent_key  Orderagent  pkey 

orderentry owner_key  Orderowner  pkey 

fulfillment agent_key  Fulfillmentagent  pkey 

request agent_key  Requestagent  pkey

returns agent_key  Returnagent  pkey 

returns owner_key  Returnowner  pkey 
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Adding the TimeRanges hotfile to ccq catalog
The TimeRanges hotfile defines appropriate time ranges for reporting within the 
Multidimensional cube. You must add the TimeRanges hotfile to the ccq catalog by:

1. In Impromptu Administrator, open the ccq.cat catalog.

2. Add the folder TimeRanges to the catalog.

3. From the Catalog menu, select Tables.

4. Select HotFiles.

5. Select the just created TimeRanges folder and select OK. The folder�s path appears 
above the Database Tables field.

6. In the Database Tables field, browse for the TimeRanges.ims hotfile to add to your 
catalog, and then select Add.

7. Select OK.

8. For drill through to Predefined, Detailed, Drill-Through Reports to work, you must add a 
join between the contact table and the timeranges table as follows:

a. Select Catalog > Joins to open the Joins dialog box.

b. Select the contact table in the Join Paths field.

c. Select the timeranges table in the Available Tables field.

d. Select Add.

e. Create the join from the options in the Join Components field as shown in the 
example from Adding the TimeRanges hotfile to repository catalog on page 129. 

Note:
Note: The join relationship in this case would be: 

hour(contact.�datecreated�) * 60 + minute 
(contact.�datecreated�) = timeranges.ims.�Time�.

f. Select OK to save the join.

Confirming catalog contents
You may confirm the contents of your Cognos catalog, including table joins, by generating 
a Content Overview report via Impromptu.

1. In Impromptu Administrator, open the catalog.

2. From the Catalog menu, select Content Overview.
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3. In the File name field, specify a name for the report. The icr extension is appended 
automatically.

4. Select the drive and directory where you wish to save the report.

5. Select Options, and select Table Join Expressions to include information about the 
table joins. You may select any other options for the catalog contents as desired.

6. Select OK, and Save.

7. Open the .icr file with a text editor. The file lists table join expressions separately 
from other information regarding the catalog. 

8. Compare the join expressions to those you entered in Generating a Cognos Catalog 
for CallCenterQ on page 130.
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Customizing the data model
Customizing the Customer Interaction Repository data model and setting up the mapping 
process is very important. The contents of EDUs can vary greatly from site to site and only 
some of the EDU names are standard across all switches. Each VRU is likely to insert 
different names into the EDU based on the information that is captured in the VRU.

You can extend the provided data model with additional fields to record more customer 
specific names in the EDU by:

1. Using Database Designer to add the fields to the tables and reconfigure the database. 

2. Using the Mapping Administration focus in the Avaya IC Report Wizard to add rules in 
the mapping tables to specify how the EDU names map to the new database fields.

3. Restarting the report server.

Full details about performing these tasks are available in IC 6.1 Administration Volume 1: 
Servers & Domains.
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Glossary

Administration screen Screen on the right side of the Operational Analyst Client interface that 
contains information about configuration settings which are selected in the 
navigation tree.

ADU Agent data unit

Agent A customer service representative (CSR). An agent is a person qualified to 
handle customer requests. He or she may deal with customers directly or just 
process customer requests.

Aggregated data Data that Operational Analyst has aggregated or summarized. Aggregated 
data has the minimum value (least), maximum value (greatest), sum, or a 
combination of those values, for each data period. Each column in the 
schema can be set to a different aggregation behavior, as long as it contains 
numeric data.
Aggregation occurs at an offset after the end of each base interval. The 
default offset is 10 minutes, but the offset can be set from 10 to 25 minutes 
by modifying the system scheduled aggregation job.

Aggregation Operational Analyst aggregates or summarizes data by selecting the 
minimum value (least), maximum value (greatest), or sum of a numerical 
measure for a particular data period. A data period involves one base 
interval. 

Aggregation job Job that aggregates data. An aggregation job summarizes data by selecting 
the minimum value (least), maximum value (greatest), sum of each data 
period, or a combination of those options. 
A system scheduled aggregation job runs at an offset after the end of a base 
interval. The default offset is 10 minutes, but the offset can be set from 10 to 
25 minutes by modifying the system scheduled aggregation job. This job 
aggregates data for that interval only.
An on-demand aggregation job can aggregate data for multiple intervals, up 
to 24 hours of data.
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Aggregation recovery 
job

Job that re-aggregates and archives container data that was not successfully 
aggregated in the past 30 hours. If enabled, the aggregation recovery job 
runs every six hours and aggregate data that was not successfully 
aggregated in previous attempts.

Analytical license key The Avaya OA license key that is used for Avaya OA, Avaya IC, and 
Advanced Reporting installations.

API Application Program Interface. An API is a set of routines that allows an 
application program to gain access to the operating system or application 
program. A developer who wants to build a program that makes requests to 
the operating system or application must use the prescribed method.

Archive The act of compressing and summarizing aggregated data into the historical 
database. While aggregation occurs every base interval, archiving occurs on 
a daily, weekly or monthly basis, with the frequency determined by your 
configuration in the Container Archives administration screen.

Archive time zone Time zone relative to which all archival jobs are performed. This value is 
specified during OA installation. It can be changed via the OA Administration 
Client.

Archived data Aggregated data that has been stored in the historical database. The data is 
categorized into daily, weekly and monthly archives.

back-end database A database that is located on a different server than the database software.

Base interval Operational Analyst lumps IC real-time data into 30-minute intervals in the 
historical subsystem.
Also called intervals.
See also base interval data.

Base interval data Real-time data that Operational Analyst has lumped into 30-minute intervals. 
The real-time subsystem summarizes IC data into 30-minute intervals and 
transfers it to the historical subsystem, which proceeds to aggregate the 
base interval data into containers.

CMS Standalone 
license key

The Avaya OA license key that is used for Avaya OA and CMS installations.

Container Metadata that defines how data should be sifted and stored in the historical 
database. The term "container" encompasses both the table definition as 
well as the data contained in the table.
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Container aggregation 
job

Scheduled job that aggregates selected containers. You specify the 
aggregation period and select the containers in the Scheduled Jobs 
administration screen.

Container data purge 
job

Scheduled job that purge aggregated and archived data. You specify which 
data in the containers and archives to delete in the Scheduled Jobs 
administration screen.

Container filter Container definitions that you customize. A filter determines which fields of 
the base interval data are aggregated into a container. It specifies the name, 
data fields and default values for each container.

Container limit Limit or constraint that you set on your containers. This enhances data 
calculation performance and disk usage. You can configure the maximum 
number of containers and rules in the Container Limits administration 
screen.

Container profile Includes the definition and the name of a container. Container profiles 
contain rules that detail what fields a container should have and what sort of 
data it should collect. Each container has a profile which has a filter that may 
contain from one to 100 rules.

Container rule Defines which rows of data in the historical store should be collected. Each 
container has a profile and a profile may have from one to 100 rules.
Also called filter rules or rules. 

Coordinated Universal 
TIme

Coordinated Universal Time (UTC). Formerly called Greenwich Mean Time 
(GMT). UTC reflects the time in the prime meridian and uses a 24-hour 
format. For example, it uses 14:00 to represent 2:00 p.m.
Operational Analyst stores data in UTC but converts the time to the local time 
of the client.

CORBA Common Object Request Broker Architecture. CORBA is a way to create 
and manage distributed program objects in a network. It lets programs 
developed by different vendors or programs scattered throughout different 
servers communicate. A program in a client can request services from a 
program in a server without having to understand where the server is in a 
distributed network or what the interface to the server program is.

Current schema The existing schema that is being used. The current schema is the 
pre-migration schema. 
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Daemon A program that runs continuously in the background and handles periodic 
service requests. The daemon forwards the requests to other programs or 
processes them as appropriate. 

Daily interval A 24-hour shift that Operational Analyst uses for real-time statistical 
reporting.

Data dictionary A database about data and databases. The data dictionary holds the name, 
type, range of values, source, and authorization for access for each data 
element in the contact center's files and databases.

Data manager An interface service that resides on a server where a real-time subsystem is 
installed. The data manager receives events, maintains real-time status 
information, summarizes data into fixed thirty-minute intervals, and forwards 
the data to the forwarders, a set of real-time subsystem services.

Data type Category of data. Each type is a set of data with values that have predefined 
characteristics and has a specified range of values and a specific way of 
being processed by the computer and stored by the database. 

Database check job A job that inspects the overall state of the historical database. A database 
check job fine-tunes the database by scanning the database and its error 
logs, as well as updating the statistics on tables. It also reports inconsistent 
metadata and rolls over the error log file to prevent it from growing 
unbounded. It runs daily if enabled.

Default schema Schema that is pre-configured in Operational Analyst. You can revert back to 
the pre-configured default schema if you decide to discard your changes. 
You need to migrate your data, however.

Detail data Historical data that cannot be aggregated.
Detail data contains information about the work item, such as the customer 
ID, work item ID and the origination.

Detail data purge job Scheduled job that purges selected detail data. You select which detail data 
to purge in the Scheduled Jobs administration screen.

Disabled container Container that is not collecting or aggregating data.

Disabled interface 
service

Data collection service that is not running.

Disabled job A job that has been configured but is not activated to run.
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Display name A meaningful name associated with a value in the database. For example, 
instead of displaying the agent ID, Operational Analyst Administration Client 
displays the agent name; so it will display "John Smith" instead of 
"1021454540554."

EDU Electronic Data Unit

Enabled container Container that is collecting or aggregating data. 

Enabled interface 
service

Data collection service that is running.

Enabled job A job that will execute at scheduled times. See also disabled job.

Event An activity or change of state that occurs in a contact center. Examples 
include: a change in port state, an agent logging in, or a call transfer.

Execution frequency See recurrence.

External job Custom-designed instruction set that specifies when certain processes 
should be executed. You can add an external job, whose scripts reside in the 
historical server, into Operational Analyst Administration Client and schedule 
its execution.

Failed Data collection status that indicates database errors.

Filter See container filter.

Filter rule See container rule.

Flat file An independent data file that is not related to another file. Flat files can be 
related to other data files, but only if you program them to do so.

Forwarder An interface service that resides on CMS or real-time subsystems. The 
forwarder transfers the data it receives to its corresponding recorder. When 
the recorder is not available, the forwarder buffers the detailed data until the 
recorder is on-line again.

FQDN Fully-qualified domain name
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GMT Greenwich Mean Time. Also known as UTC (Coordinated Universal Time). 
GMT reflects the time in the prime meridian and uses a 24-hour format. For 
example, it uses 14:00 to represent 2:00 p.m.
Operational Analyst stores data in UTC but converts the time to the local time 
of the client.

Historical database Where all historical data about your contact center is stored.

Historical store Storage location where historical or long-term contact center performance 
information is stored in a database. Each historical store consists of a 
database table or a group of database tables. Operational Analyst has 11 
stores that accumulate a variety of report-related data from IC or ACD 
systems.
The IC historical stores are: 

● Agent service class

● Agent state

● Service class summary

● Service class state

● Display names

The ACD historical stores are:

● CMS agent summary

● CMS call work codes

● CMS skill summary

● CMS VDN summary

● CMS call history

● CMS display names

Historical subsystem Along with the source subsystem, real-time subsystem, reporting subsystem, 
and CMS subsystem, the historical subsystem constitutes the Operational 
Analyst data collection system. The historical subsystem pertains to all 
Operational Analyst components and services that involve historical data.

IC Avaya � Interaction Center.

IDL See Interface Definition language.

Incomplete Data collection status that indicates there is missing data and the container 
or archive is missing at least one base interval data.



IVR system (IVRS)

Issue 1.0 August 2003 143

Info store Historical store with a group of database tables that keeps track of the 
display names for the data fields.

Installation directory Directory where the software is installed. In this document, the installation 
directory is represented by the following variables:
$PABASE (for Solaris, the default installation directory is
/export/home/biadmin/BI)
%PABASE% (for Windows, the default installation directory is
c:\Program Files\Avaya\BI)

Interface definition 
language

A language used to communicate with various software components in a 
CORBA network.

Interface service Process that automatically collects data in the background while the system 
is up. An interface service handles periodic service requests and forwards 
the requests to other programs or processes as appropriate. The Operational 
Analyst interface services include:

● Data manager

● Report data server

● Report Framework

● The respective forwarders and recorders for each historical store.

Interface service name The internal name that Operational Analyst Administration Client uses to 
identify, enable and disable the services. You cannot change the names of 
the services. 

Interval data See base interval data.

IVR Interactive Voice Response. A technology that allows callers to issue 
commands to a computer without agent intervention. For example, a bank 
customer can obtain account balance information by entering an account 
number on a touch tone phone.

IVR port Part of an IVR system. An IVR port provides interactive voice response 
services for incoming calls, acting as a virtual agent. Each port uses one 
phone extension on the PBX and can handle one phone call at a time. 

IVR system (IVRS) A server that processes calls using interactive voice response (IVR) 
technology. An IVRS contains a large number of IVR ports. The IVRS is 
connected to the PBX, which routes incoming calls to the IVR ports
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Java database 
connectivity

Java Database Connectivity. An application program interface (API) 
specification for connecting Java programs to a database. The API lets you 
request statements in Structured Query Language (SQL) which are then sent 
to the program that manages the database.

JDBC See Java database connectivity.

Job Instruction set that specifies when certain processes should be executed. 
The Scheduled Jobs administration screen enables you to automate certain 
tasks such as data purges and aggregation.

Migration The process by which Operational Analyst alters the database tables to 
conform to a new schema.

MSMQ Microsoft Message Queue. MSMQ is a software program that allows 
programs to send messages to other programs.

Navigation tree Tree that appears on the left side of your Operational Analyst Administration 
Client interface, and contains various configuration tools for customizing and 
managing data collection.

No data Data collection status that indicates no data exists. Operational Analyst did 
not find matching records. 

Not null Clause in a column or field that specifies that the column or field cannot 
contain a null value. You must define a default value.

Null Special value in the database which represents an unknown value. A null 
value is not the same as blank (which is a valid character), zero (which is a 
valid number), or a zero length string.

On-demand job A job you define to execute tasks on specific data at a particular time or 
recurrence. An on-demand job is different from a system scheduled job in 
that it is limited in scope and applies to selected data. On-demand job types 
include:

● Aggregation

● Container purge

● Detail purge

● Data collection

● External
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Operational license 
key

The Avaya OA license key that is used for Avaya OA and Avaya IC 
installations.

ORB Object Request Broker. ORB is the programming code in CORBA that 
mediates between a client and a distributed object. It enables clients to 
request services without having to know the location of the server in a 
network.

Parameter A piece of information, such as a file name, a coordinate, or a range of 
values, that is passed to a program by a user or another program.

Pending schema A custom-defined schema that is not implemented until migration.

PID See Process ID.

Precision Specifies the maximum total number of decimal digits that can be stored, 
both to the left and to the right of the decimal point. The precision must be a 
value from 1 to 15.

Process ID Identification number for a container delete job. You can determine the PID of 
a deleted container by looking at the Container Status screen.

Purge The deletion of selected container data or detail data.

Purge job A job that deletes selected containers and detail data from the historical 
database. A purge job is different from a system-scheduled purge job in that 
it is more focused and deletes only particular pieces of data you specify in 
the Scheduled Jobs administration screen.

Queue A virtual queue where Work Items are placed by the routing engine while 
they wait for service. Queues generally hold Work Items of the same type.

RAID Redundant Array of Inexpensive Disks

Real-time subsystem Along with the source subsystem, historical subsystem, reporting subsystem, 
and CMS subsystem, the real-time subsystem constitutes the Operational 
Analyst data collection system. The real-time subsystem pertains to all 
Operational Analyst components and services that involve real-time data.

Recorder An interface service that resides in the historical subsystem. The recorder 
time stamps the data it receives from the forwarder and inserts the data into 
the historical database.
There are up to 11 recorders, one for each historical store. 



Recurrence

146 Operational Analyst R6.1 Reports Reference

Recurrence The start date and end date of a job, or the number of times a job should be 
executed. For example, you can schedule a job to execute on April 3, 2002 
or once a week. Recurrence is part of the job definition.

Report Framework The self-contained Operational Analyst reporting framework application 
programming interface (API) that provides an environment to create reports 
based on the Operational Analyst real-time data. It is a framework that lets 
you develop servlet-based applications for Web-based reporting and 
monitoring for your contact center.

Retention period The length of time Operational Analyst retains data.

Rule See container rule.

Scale Specifies the maximum number of decimal digits that can be stored to the 
right of the decimal point. Scale must be a value from 0 through precision. 
Maximum storage sizes vary, based on the precision.

Schema Defines aspects of the database, such as attributes (fields) and domains and 
parameters of the attributes.

Select To select an item, click the item's name or icon. Selected items appear 
highlighted on the screen.

Service See interface service.

Service class A logical category used to measure service levels and define goals for that 
work. A particular service class can consist of any combination of interaction 
source (such as call, fax, or email), customer class (such as Platinum, Gold, 
or Silver), or activity (such as new loan or account inquiry). 
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Shortcut menu

Skill An attribute that is assigned to an ACD Agent. Agent Skills can be thought of 
as the ability for an Agent with a particular set of skills to handle a call which 
requires one of those skills.

Source subsystem Operational Analyst subsystem that collects all ACD and IC event data.

SQL See Structured Query Language.

Status window Window on the results screen that lets you view the status of elements such 
as your schemas or interface services that you have set up.

Store See historical store.

String A data type contained in the column of the table which is composed of a 
sequence of characters usually representing human-readable text. The 
column must be a contiguous set of alphanumeric characters that does not 
contain numbers used for calculations. Names, addresses and error 
messages are examples of strings.

Structured Query 
Language

Structured Query Language. The standard programming language for getting 
information from and updating a database. Queries let you select, insert, 
update, find out the location of data, etc.

To Press

Cancel multiple selection of 
items in the status window

Shift + up (or down) arrow key

Copy Ctrl + C

Cut Ctrl + X

Move to the next item on the 
screen

Tab

Move to the previous item on the 
screen

Shift + Tab

Paste Ctrl + V
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Subsystem A major component that constitutes the Operational Analyst data collection 
system. The available subsystems are:

● Historical 

● Real-time

● Reporting Framework

● CMS

● Source (ACD and IC)

Successful Data collection status that indicates data was successfully archived or 
aggregated.

Summary data Data that pertains to the performance of the contact center. While detail data 
tracks work items, summary data tracks agents and IVR systems. Summary 
data is also aggregated and, if configured, stored in containers and archives.
These historical stores contain summary data:

● Agent service class

● Agent state

● Service class summary

● Service class state

● CMS agent summary

● CMS call work codes

● CMS skill summary

● CMS VDN summary
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Summary historical 
store

A historical store that contains aggregated data. Available summary 
historical stores are:

● Agent service class

● Agent state

● Service class summary

● Service class state

● CMS agent summary

● CMS call work codes

● CMS skill summary

● CMS VDN summary

Sun ONE Web Server The new product name for the Solaris Web server, formerly iPlanet.

System scheduled 
aggregation job

A job that aggregates base interval data. This job executes on every base 
interval, that is, in 30-minute increments, if enabled.

System scheduled job A job that is executed on a system-wide level. This job applies to all the 
containers and data in the system. The following types of jobs are system 
scheduled jobs: aggregation, aggregation recovery, ACD display name 
collection, database check and database purge.
See also on-demand jobs.

System scheduled 
purge job

A job that deletes container and detail data from the historical database 
according to the data retention limits defined in the Retention Periods 
administration screen. A system-scheduled purge job is different from 
on-demand purge jobs in that it executes on the entire system and not just on 
a particular set of data, and it runs regularly, not periodically. This executes 
daily, if enabled.

Tree A way of structuring information, where sublevels are shown as branches of 
a higher level. The navigation tree in Operational Analyst Administration 
Client contains a tree of configuration tools. Items on a tree are also referred 
to as nodes.

Unicode A character set that can accommodate the alphabet of most of the world's 
languages. Unicode can handle 65,536 character combinations rather than 
just 256, and uses two bytes for each character rather than one.
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UTC Coordinated Universal Time. Formerly called Greenwich Mean Time (GMT). 
UTC reflects the time in the prime meridian and uses a 24-hour format. For 
example, it uses 14:00 to represent 2:00 p.m.
Operational Analyst stores data in UTC but converts the time to the local time 
of the client.

Widget A graphical user interface element that lets you interact with the application. 
Examples of widgets include drop-down lists, buttons, text boxes, and radio 
buttons.

Work item Data that describes the flow of work through a business process. This data 
may include details about the agents involved with the work, the amount of 
time the item spent in various queues, and any follow up calls.

Workflow The flow of work in a business process; work travels from one point to 
another so that necessary tasks can be completed on that piece of work.
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